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CONHECA UM ITEM DIFERENTE, REVOLUCIONARIO,
DE BAIXISSIMO CUSTO E PEQUENO.

Micros B-Bits Wireless

8-bits para todos os tipos de
aplicagio. Enconire o seu
aqui.
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kits prontos com as mais
diversas solugbes.
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geragiio o preges imbativeis,
néo deixe de conferir.
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Livros em Portugués

Literatura tecnico de quali-

_ dode, indispensavel para

vma utilizacio maximizada.
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Confira nossa selegdo de
componentes e kits para
comunicagio sem fio.
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Venha conhecer nossa
ogenda de Cursos Técnicos
disponiveis.
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Editorial

Estamos nos aproximando de mais uma eleicdo e o processo de votacao
utilizado em nosso pais tem servido de exemplo de aplicagao de tecnologia para os
demais paises. Apesar deste processo de contagem de votos ja estar praticamente
“consagrado’, ainda resta uma série de questoes a respeito principalmente da
confiabilidade do processo. Consultamos entao alguns especialistas da area para
responder essas questdes.O importante é ter em mente que se trata de um processo
que esta sendo aprimorado a cada eleigao.

Com a evolugao dos computadores pessoais, as portas paralela e serial estao
se tornando cada vez mais raras. A tendéncia é que elas sejam substituidas pelas
portas USB. A maioria dos notebooks atuais ja nao vem mais com portas paralela e
serial, porém, no universo eletrénico, estas portas ainda sdo muito utilizadas e nao
é dificil acontecer de necessitarmos de uma porta serial e nao dispormos dela em
um computador. A fim de ajudar a superar esta dificuldade, a presente edigao traz
um conversor USB-Serial e Serial-USB, ferramenta muito (til para o interfaceamento
de projetos eletronicos com o PC.

E pensando naqueles que estdo adentrando agora ao universo eletrénico,
trazemos o “quebra-cabecas eletrénico” que, além de ser uma montagem bastante
simples, serve como demonstracdo do funcionamento do diodo, permitindo
aprender noc¢ées de légica digital. E o melhor de tudo, & que isto é feito de uma
forma interessante e divertida.

Paulo Gomes dos Santos
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Modulos
Hibridos de |
RF-ET 110

“Em quais faixas de freqliéncia
posso encontrar esse modulos? Qual
a diferenga de faixa que devo ter de
um para outro?”

Tiago dos Santos

Técnico — SMP

Amparo / SP

Vocé pode encontrar os modulos
em 315 e 433 MHz. A diferenga de
faixa entre os modulos deve ser de, no
minimo, 100 KHz.

Termoémetro Digital
HET111

“Onde posso encontrar o Cl
DS1620 Termémetro Digital Dallas,
encapsulamento DIP 87"

Geison Pereira

Taubaté / SP

O CI DS1620 da Maxim Dallas é
facilmente encontrado em lojas de
componentes elelrénicos. Caso vocé
nao encontre o referido Cl nas lojas de

sua regido, poderd recorrer a Farnell,
www.farnell.com.br. Em uma consuita
feita em agosto verificamos
a presenga do Cl nos
estoques deste distribui-
dor.

Transistores

“Vocés conhecem algum transistor
de 200 A?”

Leonardo Soares

Cidade - BA

Existem Mosfets e IGBTs com
essa corrente, mas ndo conhecemos
nenhum bipolar.

Linguagem C-ET 102

“Quando tento compila-lo pelo
DEV-C++, é exibida uma mensagem
de erro acusando nao conhecer os
comandos “outp()” e “inp()". Contudo,
esses mesmo comandos S&o reco-
nhecidos automaticamente pelo PACI-
FIC-C. O que pode estar ocorrendo?”

Luciano de Melo

Sao Paulo / SP

As fungbes outp() e inp() néo
sdo reconhecidas pelo compilador
DEV-C, pois as mesmas ndo existem
na biblioteca do compilador. Para usar
a porta paralela no DEV-C é neces-
sdrio a instalagdo de uma biblioteca,
como a INPOUT.DLL que pode
ser obtida gratuitamente no site
www.logix4u.net/inpout32.htm. Na
edicdo 105 comegamos uma nova
série, demonstrando o uso da porta
paralela, fornecendo dados importan-
tes sobre a mesma. A série foi encer-
rada na edigdo 107. Foi explicado
também como ampliar o ndmero de
enlradas e saidas da mesma. Nela
fornecemos programas desenvolvidos

para o compilador Pacific-C, utifizando
0s comandos outp() e inp(), e também
para o DEV-C utilizando a biblioteca
INPOUT.DLL.

Onde estudar

Eletronica?

Tubarao - SC i
Curso: Tecnologia em Eletroeletrnica

Entidade: Unisul — Universidade do Sul

de Santa Catarina

Duragéo: 6 semestres

Mensalidade: R$ 430

Fone: (48) 3621-5600

Site: www.unisul.br

Recife - PE

Curso: Engenharia Elétrica com énfase
em Telecomunicagoes

Entidade: UPE - Universidade de Per-
nambuco

Duragao: 9 semestres

Mensalidade: Gratuita

Fone: (81) 3445-3855

Site: www.upe.br

Séo Paulo - SP

Curso: Engenharia Eletronica
Entidade: Universidade Sao Marcos
Duragao: 10 semestres
Mensalidade: R$ 880

Fone: (11) 3471-5700

Site: www.smarcos.br

Escreva para a
Eletrénica Total:
Rua Jacinto José de Aragjo, 315.
CEP 03087-020 - Sao Paulo - SP,

ou e-mails através do site:
www.eletronicatotal.com.br/contato

As mensagens devem ter o nome completo,
ocupagao, cidade e estado. Por motivo de
espaco, os textos podem ser editados por
nossa equipe.
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Se o custo do seu projeto esta muito alto,
a Holtek tem microcontroladores com a
Tecnologia que vocé precisa e com o
Baixo Custo que vocé quer

Linha de Microcontroladores
Reprogramaveis MTP*

Clock Memdria Memdria Memdria Timer Interrup.
Sistema  Programa Dados EEPROM 8-Bit 16-Bit Ext.  Int

WIBEDS 22055V A00KH~BAz T6i4 646 B8 T3 1 1

Part. No. VoD

I
HT4BEI0 2.2V~5.5V 400kHz~BMHz  1Kxl4 LET 1268 19 1 1 1 v
NBEID 2255V d0GKHz~BMMz 2004 96@ 1288 28 1 = 1 1w A 24SKDIP/SOP 28SKDIR/SOP £
HT48E50 2.V~55V 400kHz—8MHz ~ 4Kd5 1608 2568 33 | I 1 2 Wt b 28SKDIP/SOP, 48550P
HIABEID 20V--550 dOOKiz—BMz 8616 2248 268 56 - 21 T < W £

485507, &

*Multi Time Programmable

! I/W" | |
' #

Ideal para aplicacoes
com matrizes de LED/Clusters

: *f Alta capacidade de correntes nas portas (40mA)
ontrolador ‘Ho

4BRS‘ZA Baixo consumo em operagéo (3V - Idd= 300pA)

Grande numero de portas
- Disponivel'no encapsulamento 52QFP

Kit de Gravacao In-Circuit de
Baixissimo Custo

CI KA

Eletronica
Distribuidora de
Componentes
Eletrénicos

. Rua Belo Horizonte, 102

. Belenzinho - Sao Paulo - SP

- Brasil - CEP 03052-040

- Tel.: (11) 6693-6428

| Fax: (11) 6693-8805

.~ www.cikaeletronica.com

. vendas@cikaeletronica.com



Noticias

G CNPq oferece bolsas de estudo no Brasil e exterior

Que tal turbinar a sua for-
macéo e ainda ser remunerado
por isso? O Conselho Nacional
de Desenvolvimento Cientifico
e Tecnolégico (CNPq) esta
oferecendo bolsas individuais
de formacdo e de pesquisa
para estudantes. A bolsa de
formagao é destinada a estu-
dantes de graduacédo, mes-
trado e doutorado, e a de pes-
quisa apenas a pesquisadores
que ja possuem doutorado e
estdo desenvolvendo novas
linhas de pesquisa. Além da
formacéo cursada no Brasil, o

Inscricoes paraiEebrace

Em um esforgo conjunto
para preparar estudantes uni-
versitarios para o desenvolvi-
mento de softwares e ainda
agregar novas idéias e inova-
¢oes ao poder de seus proces-
sadores, a Intel anunciou que
apoiara os estudos de 45 das
principais universidades do
mundo no desenvolvimento
de processadores que terdo
muiltiplos ntcleos e tarefas.

conselho ainda oferece opgbes para
quem deseja desenvolver seu projeto
de pesquisa no exterior.

Nessas modalidades de bolsa, o
estudante aprovado recebe um auxilio
financeiro mensal para se dedicar
completamente ao projeto de pesquisa,
ou a sua formagao académica. Se o
aluno for selecionado para estudar
no exterior, a bolsa contempla ainda
passagens aereas, auxilio-instalacao,
auxilio seguro-saude e taxas escola-
res, de acordo com os parametros de
cada modalidade de bolsa.

Para quem deseja pleitear uma
bolsa do CNPq, no site do Universia

(0)0)

Para isso, a empresa esta direcio-
nando financiamentos, ferramentas
de desenvolvimento, materiais educa-
cionais, treinamento no local e outras
formas de colaboragédo para que as
universidades incorporem os conceitos
de multiplos nucleos no curriculo dos
cursos de Ciéncias da Computagao.

Dentre as universidades participan-
tes estdo a Universidade de Michigan
e de Washington, além de centros
académicos brasileiros como Unicamp

esta disponivel o material completo
de cada modalidade além de dicas
para encaixar seu projeto dentro das -
normas do conselho. Alguns requisitos
basicos devem ser respeitados como
relevancia e atualidade do tema,
fundamentacéao tedrica, adequagéao
metodoldgica e possibilidade de apro-
veitamento da formagao no futuro.
Mais informacgdes sobre as bolsas
em www.universia.com.br/materia/
materia.jsp?materia=11715.

Neste ano, a
Febrace reuniu 207
projetos de 22
estados brasileiros

Intel inicia convénios de pesquisa com diversas universidades

- Universidade de Campinas e USP —
Universidade de Sao Paulo. O profes-
sor da Unicamp, Guido Aradjo, acredita
que tal atitude é um investimento para
a formacédo de novos engenheiros.
“Como uma empresa de mercado,
a Intel conhece as tendéncias da
industria de computadores e semi-
condutores. Com a ajuda, temos a
oportunidade de melhorar os cursos
e prepara-los melhor para futuros
empregos”, afirma.

ELETRANICA 7075 - N° 118 / 2006




Radiacio eletromagnética aumenta com entrada da eletronica nos veiculos

Certamente alguma vez, seu radio
sofreu interferéncia quando vocé
passava por algum lugar, contudo,
vocé nao deve ter entendido o porqué.
Estar proximo a um carro dotado de
eletrénica embarcada pode ter sido
o motivo, isso porque estes sistemas
emitem radiagéo eletromagnética que
podem interferir no funcionamento
de outros equipamentos eletronicos.
“No passado, os veiculos eram eletro-
mecéanicos entdo ndo havia este pro-
blema”, conta Hélcio Onusic, coordena-
dor da comissao de eletroeletrénica da
Associacgao Brasileira de Engenharia
Automotiva (AEA).

Hoje, devido as exigéncias de
conforto e seguranga, muitos veiculos
_ ja podem ser controlados eletronica-
mente e oferecer informagdes ao
condutor sobre as reais condi-
goes do carro. No entanto, 0s

modulos eletrénicos respon-
sdveis por enviar as informa-
¢bes a placa de controle do
carro, como o0s indutores,
capacitores e, mais recente-
mente, os chips, funcionam
em determinadas freqién-
cias, assim como os radios.
Se 0s equipamentos estiverem

Em uma parceria entre diversas
associacbes e empresas do setor
elétrico, entre elas a Associacao
Brasileira da Industria Eletroeletro-
nica (Abinee) e o Instituto Brasileiro do
Cobre (Procobre), foi langado o pro-
~ gramaCasa Segura
L. que busca cons-
cientizar as pes-

soas da impor-
tancia da manu-

\ tengéo das ins-
| talagdes elétri-
cas. De acordo
com um estudo
realizado
pelo Pro-
cobre,

sintonizados na mesma frequiéncia
surgirdo os problemas. “E comum que
isso aconteca, mesmo submetendo
os veiculos a testes com o nivel de
freqiéncia 10 a 20 vezes maior”,
explica Onusic.

Causadora dessas interferéncias, a
radiagéo eletromagnética € gerada por
todo sistema eletroeletrénico durante
seu funcionamento normal, e o tema
tem sido muito discutido, inclusive
no VIll Seminario de Eletroeletrénica
aplicada a Mobilidade, promovido pela
AEA. Nesses encontros, sdo discu-
tidas maneiras
de inibir e mini-
mizar a emis-
sao de radiacédo
eletromagne-
tica pelos con-
dutores. “Esta-
mos fazendo
diversos estu-
dos sobre isso,
e desenvolven-
do uma legis-
lagdo baseada
nas normas da
ISO”, afirma o
coordenador.

ProgramalCasajSeguralincentiva’

no ano passado 50% das residéncias
com mais de 20 anos de idade ndo
passaram por nenhum tipo de reforma
nas instalagoes elétricas.

No programa-piloto, foram verifica-
das as instalagdes de 150 imoveis
neste perfil e liberados os diagnosticos
para orientar a realizacao de corregdes
nas instalagbes, ou mesmo a adogao
medidas para evitar acidentes. “Anos
atras a carga suportada pelas instala-
¢cdes era menor, devido a pequena
quantidade de produtos eletroele-
tronicos nas residéncias”, explica
Antonio Maschietto, diretor-executivo do
Procobre. Hoje, com o aumento do
uso desses equipamentos nas resi-
déncias, é preciso que as instalacoes

Maschietto - “Se a instalacao elétrica nao estiver de acordo com

co/ "

Noticias

Para resolver o problema,
a blindagem dos componen-
tes ou pequenas alteragdes
em seu projeto podem fazer
a diferenca. “Na fabricagéo,
devemos pensar no layout dos
componentes e dos cabos”, diz
Hélcio. Segundo ele, o traba-
lho no Brasil sobre o assunto
ainda é muito experimental,
mas a tendéncia é que essa
discusséao se expanda.

sejam corrigidas para suportar
o aumento de carga mas, na
maioria das vezes, isso néo
acontece. =

Agora na segunda fase do
projeto, o objetivo do programa
€ conscientizar as pessoas
de que essa manutengéo €
necessaria, até para ajudar
a reduzir os gastos com ener-
gia elétrica. Para saber como
encontrar um profissional habi-
litado pelo programa para veri-
ficar as instalagtes de sua resi-
déncia ou edificio, ou encontrar
dicas basta acessar o site
www.programacasasegura.
org.br.




Voceé trabalha 5 meses por ano sé para

-

Quero menos imposto. Quero governos gastando menos com
governos e mais com os brasileiros. Quero Mais Brasil. Se vocé
também quer, reclame agora. Vocé tem direito. Se ficar calado

Reclame e exija agora. Vocé tem o direito e o dever. Ligue 4002-8988

Apoio: ABAP + ABECE + ABO + ABRACOM - ABRALATAS « ABRAMULTI + ABRASCE « ABRASGRAOS + ABRAT « ABT » AC/CPO LIMPO + AC/JARINU « AC/MINAS
+ ACE/GUARULHOS - ACE/JANDIRA +« ACE/OURINHOS + ACEC/COTIA + ACEPAIG + ACI/BARUERI « ACI/BAURU + ACI/CONCHAS - ACI/MARILIA + ACI/MS
» ACI/SANT. PARNAIBA - ACI/SAO CARLOS » ACIA/ARARAQUARA + ACIR/AGUAS PRATA + ACISS/SAO SEBASTIAO + ACLAME « ACREFI «+ ACRJ - ACRN - ACSP
+ ADJORI/SC = ADJORI/SP + ADMSM + ADVB » AESCON/SP « AIG/RS + ALSHOP + AMB + AMCHAM + AMOBELA » AMORSIM + ANEFAC « ANEPS « ANFAC - ANJ

+ APAREM - APEJESP « APM « APROVE » ARFDS « ARI = ARP + ASBEA + ASEC » ASERC + AUDIBRA « AVITRAN » BRACELPA + CACB + CDPY » CEMAIS + CIC - CIESP - CNS
+ CNS + COB + CODEG + CONFENEN + CORCESP » CRA/SP « CRC/PR » CRC/SC » CREA/PR + CRECI + FACERN + FACESP » FECOMERCIO/SP « FECONTESP « FEHOER!
+ FEHOESP « FEMESP + FENABRAVE » FENAC + FENACON + FENAINFO + FENECON + FESESP « FETCESP « FIABCI/BRASIL + FIESP » FIRJIAN « FORCA SINDICAL « FUA




"
pagar imposto! Vai continuar calado?

QUERO MAIS

nao vai mudar nada. Vamos levar sua reclampicao
para Brasilia junto com milhoes de brasileiros iguais
a vocé. Vamos gritar. E todos os governantes vao nos ouvir.

BRASIL

ou pela Internet www.queromaishrasil.com.br ESTA BANDEIRA E SUA
ESTE PAIS E SEU

* |IAB/SP « IBCE « IBDTS - IBPT « IDESA - IDV - IE/PR + IE/SP « IEE » IF/BRASIL + IL/RS * IMEMO + INSTITUTO INNOVARE + IPC + LIDE + MCQV/RS « MONATRAN +» NTC
+ OAB/SP « OSCIP - PNBE + SAESP - SECOVI/SP + SEEAATESP « SEINESP « SEMEE| « SEMEF « SEMEM + SEPROSP - SESCAP/AC » SESCAP/BAHIA + SESCAP/LDR
+ SESCAP/PR » SESCAP/RO + SESCAP/SE « SESCAP/TO + SESCON/AMAZONAS « SESCON/B.SANTISTA « SESCON/BLUMENAU » SESCON/CAMPINAS « SESCON/DF
+ SESCON/ES » SESCON/GR.FLOPIS + SESCON/MS + SESCON/PA » SESCON/PONTA GROSSA + SESCON/RJ + SESCON/RN » SESCON/RR + SESCON/RS

« SESCON/SERRA GAUCHA « SESCON/SUL FLUMINENSE + SESCON/SC « SESCON/TUPA « SESCON/SP « SIAMFESP » SICETEL » SINAENCO + SINCOELETRICO
*« SINCOESP « SINDCONT/SP « SINDECON/ESP « SINDICONTAS « SINDELIVRE » SINDHOSP « SINDIFUP!I « SINDILOJAS + SINDIMEST « SINDIMOTOR + SINDIPROM
*» SINDISEG/PE + SINDUSCOMN/RS « SINEATA + SINEPE + SINEVIDEO +« SINFAC « SINPRAL + SINTEC/PR * SINTELMARK + SIRCESP « SRB » TELCOMP + UBRAFE




Reportagem

OBSERVE 0S DADOS [
. INFORME 0 SEU m{i"{?’ ;

Aperte a tecia
CONFIRMA pa o
CORRIGE para COn

Por dentro e
das eleicoes

Como funciona a votagao informatizada no Brasil?
A urna eletronica ¢ 100% confiavel?
Quais as novas tecnologias em implantacao nas urnas eletronicas?

ouve um tempo em que poucas
pessoas tinham o direito de
votar e guando o faziam nao tinham
nenhuma garantia de que sua escolha
seria atendida. Desde entdo as elei-
¢oes sofreram muitas modificacbes,
inclusive tecnolégicas. Contudo, o
perigo das fraudes ainda ronda essa
parte fundamental da democracia.
Voltando um pouco no tempo, é
facil lembrar gqguando o voto ainda
era realizado através das cédulas
impressas, onde o eleitor anotava a
caneta o numero do candidato que
escolheu e depositava o papel nas
urnas presentes na secao eleitoral.

O ato de votar era bastante rapido,
porém o contrdario acontecia na hora
da contagem manual das cédulas:
varios dias se passavam até que o TSE
(Tribunal Superior Eleitoral) divulgasse
o resultado da votagao. Além disso, os
casos de fraude, como a compra de
votos em troca de favores na época
das eleicdes, eram bastante comuns,
mas dificeis de serem detectados.
Com o objetivo de eliminar as
possibilidades de fraude e trazer
agilidade a totalizagdo dos votos, em
1995 foi aprovada a lei que permitia o
uso de maquinas de votar eletrénicas
sem comprovante de voto e dava ao

~ JUSTICA
ELEITORAL

TSE o poder de regulamentagao de
seu uso. Pela primeira vez, em 1996,
as chamadas urnas eletrénicas foram
utilizadas pelos brasileiros, atingindo
cerca de 35 milhdes de pessoas, 0
equivalente a um terco do eleitorado.
Ao contrario do que muita gente
pensa, a urna eletrénica é apenas
um computador que integra monitor
LCD, no-break, impressora, teclado,
dois cartdes de memoria para arma-
zenamento dos dados, além do micro-
terminal utilizado pelo mesario. “Ela
tem tudo que um computador comum
possui, a diferenca é que retine em um
gabinete sd”, esclarece o engenheiro
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Amilcar Brunazo Filho, coordenador do
Férum do Voto Eletrénico na Internet.
Além disso, a urna eletrénica possui
um firmware especifico que permite
que os softwares desenvolvidos pelo
TSE s6 sejam executados na propria
maquina.

Polémica por natureza

Com a entrada da urna eletrénica
no sistema eleitoral brasileiro, é fato
gue a contagem dos votos se tornou
muito mais rapida do que nas eleicbes
anteriores. “As 17h do dia da elei¢ao
ja é possivel obter os resultados da
secao eleitoral”, afirma Giuseppe
Janino, secretario de tecnologia da
informagédo do TSE. Entretanto, ha
divergéncias quando o assunto é a
confiabilidade do sistema.

A urna eletronica tem recebido
duras criticas de especialistas brasi-
leiros e estrangeiros que acreditam
na possibilidade de fraudes durante a
fase de programacéo. “Sabemos que o
sistema de votacao nao resistiria
a um ataque interno. Pessoas em
posi¢coes-chave no
processo elei-
toral poderiam
fazé-lo”, acre-
dita Augusto
Marcacini,
presidente da
comissao de
informatica da

OAB (Ordem dos Advogados do
Brasil). Juntamente com o Ministério
Publico e as comissdes técnicas dos
partidos politicos interessados, a OAB
é uma das responsaveis por fazer
a verificagdo do cédigo-fonte dos
programas antes da eleigcao.

Tendo as primeiras experiéncias
de viabilidade realizadas na cidade de
Brusque (SC), o processo de votagao
informatizada tem seu ponto de partida
na elaboracao e verificagéo do cadastro
unico de eleitores pelo TSE. Apos esta
etapa, ocorre a votagdo e a propria
urna emite um boletim com a apuragéo
dos votos. Os dados sédo enviados
aos Tribunais Regionais (TREs), que
totalizam os resultados estaduais,
e posteriormente ocorre a apuragéo
nacional pelo TSE. “Entre todas as
etapas existe um documento e a pos-
sibilidade de haver adulteractes”,
alerta Amilcar. Ele completa que uma
fraude durante a totalizagéo nacional
dos votos seria fatal, pois anularia
todas as apuragbes anteriores.

O TSE alega, por sua vez, que
nao existe a possi-
bilidade de fraude

Reportagem

Alguns niumeros

A cada eleigio sdo adquu‘ﬁas nwas

umas do modelo do ano vigensa

para integrar o conjunto de méqui-
‘nas e)_;isﬁentes no Ht::]ta.r existem
mais de 400 I‘I‘Il I_Jr-‘nas no Brasil.
S6 neste ano, foram iﬁvesudos cerca
de R$ 46 mllhoes de reais :
em urnas do modelo 2006. A cach

eleigdo o montante investido pe_ia:

Justica Eleitoral chega a cercajﬁé"

R$ 200 milhées

.

do WindowsCE, sistema utilizado nas
urnas eletrénicas brasileiras, pois
ele é composto de cerca de 60 mil
arquivos e o prazo de testes permitido
pelo TSE compreende apenas cinco
dias. “A validagdo do cédigo-fonte é
necessaria, pois é preciso saber se o
software que sera utilizado e honesto,
porém esse processo nao funciona
na pratica”, justifica Amilcar.

no sistema devido
a transmissao de
dados ser realizada
mediante assina-
tura _digital, pre-
viamente realizada
pelos fiscais dos
partido. Assim,
comprova-se que
o documento assi-
nado digitalmente
esta correto, como
uma assinatura de
proprio punho com-
prova um docu-

sy

Super SteplLab

A placa de laboratério mais compieta do mercado

mento impresso.
Contudo, é una-
nimidade entre os
estudiosos entre-
vistados que se
torna praticamente
impossivel verificar
todo o codigo-fonte

Fazendo a auditoria com o voto
impresso, nao é preciso se certificar

de que o software esta correto.
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O professor da Universidade
de Brasilia (UnB), Pedro Rezende,
também estudioso na area de segu-
ran¢a de dados completa que mesmo
que o codigo-fonte fosse totalmen-
te verificado, ainda assim a alteragao
poderia ocorrer durante a transforma-
cao do coédigo-fonte em programa
executavel, a chamada compilagao.
“Essa etapa impede até mesmo o TSE
de saber exatamente como sera a
versao executavel’, garante.

Em sentido contrario, Giuseppe
afirma que a seguranga no processo
eleitoral envolve procedimentos, controle
e auditorias bem definidas. “Até os dias
de hoje nao existe nenhuma fraude
comprovada”, diz. Segundo o secretario,
0 que existem s@o suspeitas investigadas
pelas autoridades competentes, mas
que nunca resultaram em comprovagao
de irregularidades.

Dados encontrados no relatério “O
maquinario da democracia: protegendo
as eleicées num mundo eletrénico”,
divulgado em 2006 pelo Centro Bren-
nan de Justi¢ca, da Universidade de
Nova lorque, apontam as diversas
vulnerabilidades dos sistemas de
votacéao eletrénicos. No caso brasileiro,
as urnas nao contam com a impressao
do voto para conferéncia do eleitor, 0
que o relatério acredita ser uma medida
poderosa para minimizar os riscos de
fraude. Se houvesse este recurso, a
conferéncia seria realizada em cerca
de 3% das urnas utilizadas na eleigao,

£ AsATh do dia da eleicao
jae posswel obter os resultados

da secao eleitoralss
Giuseppe Janino ey

missdo wireless nas maquinas, entre
outras medidas.

Novas tecnologias
no voto eletronico

O governo brasileiro esta estu-
dando novas tecnologias a serem
implantadas no sistema de votagéo
eletrénica brasileiro, entre elas a
biometria, onde o eleitor coloca seu
dedo em um leitor de impresséo digital
que compara os dados recolhidos com
o cadastro de eleitores do TSE. “O
objetivo é acrescentar mais um dispo-
sitivo de seguranca na identificagcao
do eleitor”, explica Giuseppe. Segundo

comparando os registros eletronicos
e os registros em papel. “Fazendo a
auditoria com o voto impresso, nao é
preciso se certificar de que o software
esta correto”, ressalta Amilcar.

No Brasil, nas elei¢gdes de 2002
foi realizado um teste da impressao
do voto para conferéncia pelo eleitor,
apenas em uma pequena parcela
das urnas. Neste sistema, o eleitor
digitaria seu voto e, apds a impressao
do comprovante ele teria que conferi-lo
e confirmar novamente a escolha. Por
falta de treinamento aos mesarios
e juizes eleitorais, o sistema teve
problemas e ja nas eleigbes de-2004
nao foi mais utilizado. “O processo foi
abolido, pois percebemos que esse
tipo de auditoria ndo é eficaz, pois
permite o processo manual, um meio
usual de fraudes”, justifica Giuseppe.

Diversos cientistas renomados
participaram das pesquisas do Centro
Brennan de Justiga, entre eles Ronald
Rivest, um dos inventores da técnica
de assinatura digital. Em nenhum
momento, o relatério Brennan diz que
a auditoria do codigo-fonte certificada
pela assinatura digital, como é reali-
zada no Brasil, € um método eficiente
contra fraudes, mas também nao
afirma o contréario. Para evitar possiveis
fraudes, o relatério aponta diversas
formas de fiscalizagdo que incluem o
voto impresso conferido pelo eleitor,
acompanhado da auditoria das urnas,
além de proibir mecanismos de trans-

o secretario, existem também outras
propostas de melhoria de hardware e
software da urna eletrénica.

A adog@o da biometria teria a fungéo
de acabar com a introdugéo de eleitores
inexistentes no cadastro eleitoral, os
chamados “fantasmas”. Pedro Rezende,
professor da UnB, acredita que enquanto
o cadastro de eleitores for controlado
por cada cartério eleitoral, nada se pode
fazer contra esse tipo de fraude. “A
biometria ndo deve ser implementada
em nenhum sistema eleitoral”, espera
Pedro Rezende. Ele afirma que este
sistema de identificagéo é bastante
complexo, caro e de dificil fiscalizagao.

Na Venezuela, pais que possui um
dos sistemas de votag&o eletronica rais
avangados, a biometria foi adotada nas
eleicbes de 2005, mas nas proximas
eleicoes ja sera descartada. Uma outra
tecnologia ja utilizada nesse pais séo
as telas touch screen, que dispensam o
teclado comum das urnas. Neste caso,
o eleitor toca a prépria tela da urna para
escolher a opgéo desejada. T

Saiba mais

Férum do Voto Eletrénico
www.brunazo.eng.br/voto-e/

Relatério Brennan (em portugués)
www.brunazo.eng.br/voto-
e/textos/brennan|.htm

Site do Prof°® Pedro Rezende (UnB)
www.cic.unb.br/docentes/pedro/

Site do Tribunal Superior Eleitoral
www.tse.gov.br
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Montagem

USB/RS-232.

circuito proposto neste artigo
permite ao usuario mandar e
receber dados para a porta
USB de um PC, usando o protocolo
RS-232, o qual ja se encontra inte-
grado (embedded) na maior parte
dos microcontroladores. As principais
funcionalidades do circuito s&o:

* Conector USB diretamente na
placa, ndao havendo necessidade de
um cabo USB;

* Pinos para a comunicagdo
RS-232 em aberto, possibilitando
a ligagao de qualquer aparelho de
comunicagao RS-232;

» Conexao RS-232 trabalhando em
uma velocidade de transferéncia de
dados de 9600 bauds.

A base do projeto é o microcon-
trolador da Microchip PIC16C745,

Conversor
s USB-USB/RS-232

André Luis Marques Marcato*
Leandro de Mattos Braga**

Ha algum tempo foi introduzida nos PCs uma nova porta
para comunicagées do tipo serial com periféricos externos: a
USB (Universal Serial Bus), mas a grande maioria de desenvol-
vedores de circuitos microcontrolados ainda utilizam a porta
serial RS-232 para a comunicagao com o microcomputador.
Porém, esta escolha esta com os seus dias “contados”. Alguns
PCs modernos ja saem de fabrica sem suporte a porta serial
RS-232 (é o caso da grande maioria dos “notebooks” e
até mesmo PCs “desktop”). Para ajudar a resolver esse
problema este artigo propée um conversor RS-232/USB -

que internamente possui um moédulo
USB, os comandos para acessar esse
periférico estdo no firmware que pode
ser adquirido na se¢éo downloads no
site da revista.

Este circuito € muito simples de
ser montado, inclusive por pessoas
com pouca experiéncia pratica em
bancadas de eletrénica.

E importante salientar que o dispo-
sitivo proposto ndo podera realizar a
troca de informagdes entre duas placas
similares. Ou seja, é imprescindivel a
presenca de um PC (Host) do outro
lado do circuito, pois é necessario
existir drivers especificos, os quais séo
encontrados nos principais sistemas
operacionais (Windows, Linux, MacOS).
Estes drivers possibilitam o controle do
médulo USB do PIC 16C745.

N

Onde usar

Este projeto podera ser aplicado
em diversas situagdes como:

» Transferéncia de dados de uma
placa microcontrolada para um PC;

« Confecgéo de um controle remoto
o computador pessoal, como, por
exemplo, o click do mouse, permitindo
que o apresentador de uma conferén-
cia troque os slides a distancia;

* Interligacdo de médulos hibridos
para transmissdo/recepc¢ao de dados
RF diretamente ao computador pes-
soal.

O Circuito

Na figura 1, & possivel ver o circuito
que compde o sistema. O controle
é feito por um microcontrolador PIC
16C745 da Microchip. Ele controla os
pinos TX, RX responsaveis pela comu-

Importante

Nzo serdo fornecidos os detalhes
sobre a gravagdo do microcontrolador,
pois assumimos que os leitores que
se propuserem a montar este circuito
possuem a experiéncia necessaria
com microcontroladores Microchip
e, portanto, conhecem 0S processos
envolvidos em sua operagéo/gra-
vagao.

= ETHRARICA TATO _ KO 1182 /004



nicacdo RS-232 e
o periférico USB do
sistema.

Repare que o
microcontrolador
estd sendo ali-
mentado pela porta
USB do PC, néao
havendo necessi-
dade de uma fonte
externa.

O cristal oscila-
dor do PIC é impres-
cindivelmente de 6
MHz diferente de
montagens conven-
cionais que utilizam
o de 4 MHz, se o
cristal nao for de 6
MHz o circuito nao
funcionard, pois nao
sera possivel para
o microcontrolador
- gerar um diagrama
de temporizacgédo

Montagem

Figura 1 - Esquema do circuito do conversor
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compativel com o principio de funcio-
namento do USB.

O leitor ndo deve esquecer da
ligagao do pino GND com o dispositivo
RS-232, que ird se comunicar com 0
dispositivo proposto no artigo.

Foi utilizado um ClI MAX232 que
tem a funcédo de adequar os niveis de
tens@o da saida do microcontrolador
com os niveis de tensao do barramento
RS-232.

Montagem

Na figura 2, o leitor tem nossa
sugestao para o fayout do circuito
impresso. Se preferir, também é pos-
sivel montar o circuito em uma placa
padrdo ou mesmo em uma matriz
de contatos, sendo este Ultimo caso
recomendado apenas para testes e
provaveis alteragdes no circuito.

Sugere-se o uso de soquete para
o microcontrolador. Tenha cuidado
ao soldar o Cl, pois o aquecimento
excessivo pode levar a queima. O
conector USB (figura 3) tera de ser
soldado em baixo da placa.

O Programa

O programa para o microcontrola-
dor foi desenvolvido utilizando o pacote
computacional PCWH Compiler. Atra-
vés deste software, o usuario pode
usar a linguagem C para a criagédo de
programas para o microcontrolador
PIC. O compilador gera automatica-
mente o arquivo bindrio (\HEX) que
corresponde ao programa que sera
gravado no microcontrolador PIC. O
quadro 1 mostra a primeira parte do

Figura 3 - Conector USB

programa, na qual
séo definidas algu-
mas variaveis de
ambiente e algu-
mas fungdes que
serdo utilizadas no
programa principal
(main program).

E interessante
observar que a
diretiva de compi-
lagdo USE RS-232
é usada para defi-
nir a velocidade
de comunicacao
serial. Neste exem-

PINB3, PARITY = N, BITS = 8,

#define USBPIC16C765 1

// Define microcontrolador a ser utilizado
#include <16C745.h>

#device *=16

#fuses HS,NOWDT,NOPROTECT

#use delay(clock=24000000)

#use RS-232 (BAUD=9600, XMIT = PINBZ RCV =
STREAH = ENTSAI)
//Define variaveis de ambiente

#define USBHIDDEVICE TRUE

#define USBRUNWHENCONFIGURED TRUE
#define USBEPITXENABLE :

#define USBEPITXSIZE 2

fdefine USBEPIRXENABLE 1

#define USBEP1RXSIZE 2

//Bibliotecas para utilizagdo do USB
#include “picusb.h”

#include “usb.c”

boolean Transmitiu;

plo, foi utilizada a
taxa de comunica-
¢ao de 9600 bauds,

opinoTXéoB2, 0 {

int8 outdata[USBEP1TXSIZE];
int8 indata[USBEP1RXSIZE];

void piscaverde()

pino RX é B3, 8 bits outputhigh(pinB0);

de dados e sem delay ms {250);

bit de paridade. O outpuriowieiart:
; delay ms(250);

leitor pode configu-
rar esta diretiva de
acordo com a con-
figuracao do barra-
mento serial que
sera empregado.

O quadro 2
apresenta o pro-
grama principal que,
inicialmente, envia
a sequéncia de
caracteres corres-
pondente a palavra
“Saber”. Em seguli-
da, o programa entra em um foop
infinito onde ficara monitorando tanto o
barramento USB quanto a porta serial
em busca de um caractere. Quando
um caractere for recebido pela porta
serial, o0 mesmo sera imediatamente

}

{
outdata[0]
outdata[1]

{
B TOGGLE) ;

}
}

.

W
O

cy 4

H1 o

C7

b R

USB 01 E 9 %
c
E: 1C3 E % i
Bl 2-CJ g ‘C
= PLED 1 Qic
51 S
1]

Quadro 1 - Programa do microcontrolador PIC - Parte |

Figura 2 - Layout para circuito impresso do conversor

void RecebeByte(int letra)

= OxAA;
= letra;

usbwaitforenumeration();
if (usbenumerated())

usb put packet(l, outdata, USBEP1TXSIZE,

transferido para o barramento USB.
Por outro lado, quando um caractere
for recebido pelo barramento USB sera
enviado para a porta serial.

A interpretacao detalhada do pro-
grama em C, ndo € o objetivo deste
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artigo. Para os usuarios que desejarem
gravar diretamente o programa no
PIC, o arquivo PIC_USB.HEX esta
disponibilizado em nosso site.

Prova e uso

Ap6s montar o circuito (placa), faca
uma revisdo no mesmo para evitar
“surpresas” desagradaveis. Reveja
todas as ligagoes, placa, etc. Feito
isso, é hora do teste final.

Grave o microcontrolador com o
codigo HEX fornecido em nosso site e
instale o mesmo na placa.

void main()
{
boolean sai;
int8 comandol, comandoZ2;
int8 letra, teste;
sai = 1;
piscaverde();
fputc ('S’,ENTSAI);

delay ms(2);

fputc ('A’,ENTSAI);
delay ms(2);

fputc ('B’,ENTSAI);
delay ms(2);

fpute ('E’,ENTSAI);
delay ms(2);

fpute ('R’,ENTSAI);
delay ms(2);
usbinit();

while (sai == 1)

{

usbwaitforenumeration();

while ( (usbenumerated()) && (sai == 1))

{
if (usbkbhit (1) )
{

usb gets(l, indata, USBEP1RXSIZE);

comandol = indata[0];
comando2 = indata[l];

if ( comandol == 0OxAA )

{

fputc (comando2, ENTSAI);

delay ms(2);
}
}
if (kbhit())
{

letra = fgetc(ENTSAI);

if { letra > 0 )
{
recebebyte (letra);
}
}
}
}
resetcpu();

}

Quadro 2 - Programa do microcontrolador PIC - Parte Il

Instale no seu micro o programa
que esta contido no arquivo compac-
tado SABER.ZIP, também fornecido
em nosso site. Este programa enviara
e recebera bytes pela porta USB
(figura 4).

Execute o hyperterminal do Win-
dows. Para acessar este programa,
vocé deve clicar em Iniciar, em seguida
em Programas, depois em Acessorios
e finalmente em Comunicagdes. Apa-
recerd um menu e uma das opgdes
é hyperterminal. Siga os passos for-
necendo as informagdes para confi-
gurar a comunicacdo RS-232 (9600
bauds, bits de dados 8, paridade:
nenhum, bits de
parada: 1, controle de
fluxo, nenhum).

Conecte o cabo
serial ligando o micro-
computador ao circui-
to. Em seguida, ligue
o circuito ao compu-
tador atraves do cabo
USB. Neste momento,
o LED piscara e
aparecera a palavra
SABER na janela do
hyperterminal.

Agora é s6 brin-
car com 0 programa
e circuito. Escre-
vendo alguma coisa
na caixa de texto
e depois clicando
no botdo “man-
dar”, a palavra sera
enviada para o hyper-
terminal. Por outro
lado, se vocé clicar
em “Gera Arquivo”,
tera seis segundos
para ativar a janela
do hyperterminal e
digitar qualquer texto,
finalizando com
ENTER. O texto sera
enviado para o
arquivo SABER.TXT.

Com um pouco
de animacéo e pra-
tica de eletrénica e
programag¢ao vocé
podera adaptar este
projeto para uma infi-
nidade de aplica-
¢oes!

"Figura 4 - Programa SABER.EXE para
receber e transferir dados pela USB do PC

Conclusao

Neste artigo foi demonstrado como
montar um conversor RS-232/USB
microcontrolado, que pode ser usado
em diversas aplicagbes para troca
de dados com o microcomputador. O
circuito proposto pode servir como
base ou complemento de muitos outros
circuitos envolvendo comunicagéao
com o PC, sendo uma peg¢a chave em
um possivel produto comercial. Boa
experiéncia e até a proxima! T

Lista de materiais

Semicondutores

Cly - P1C16C745 — microcontrolador
Microchip®

Cl; - MAX232

D, - Diodo Si — 1N4148

LED, - Verde @5 mm

Resistores (1/8 Watt)

R4, Ry - 4,7kQ (amarelo, violeta, ver-
melho)

R, R, - 1kQ (marrom, preto, vermelho)

Capacitores

C4, C, - 33pf — cerdmico

C; - 330nF — poliéster

C4 a Cg - poliester — 1 uF/50 V

Diversos

Cristal ou Ressonante Ceramico de 6
MHz e conector USB'

Cabo Serial

www.eletronicatotal.com.br

- Layout da placa de circuito impresso;
- Arquivo PIC_USB.HEX, para grava-
¢ao do microcontrolador;

- Arquivo SABER.ZIP, para enviar e
receber bytes pela porta USB.

*André Luis Marques Marcato é professor
da Faculade de Engenharia da Universidade
Federal de Juiz de Fora.
** Leandro de Mattos Braga ¢ professor do
Colégio Técnico Universitario da Universidade
Federal de Juiz de Fora.
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IWinAVR

- O leitor sabe da
importancia dos mi-
crocontroladores no

‘mundo moderno. Eles |

estao presentes em
muitos equipamentos

que utilizamos no dia- |

~ a-dia e, portanto, as
- chances de obter um
- bom emprego nesta
~ 4rea aumentam muito
 acada dia.

~ Aprender a lidar |

com microcontrola-
- dores hoje nao é mais
um desafio, mas uma
~ necessidade! E a Lin-

~ guagem “C” é atual- |
mente uma das mais |
usadas na progra-
~ macao dos micro- |

controladores. Neste
~ artigo, o leitor rece-
 bera todas as dicas
necessarias para ins-
talar e usar um compi-
lador da Linguagem C
para a linha de micro-
controladores AVR.
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O compilador WinAVR e o
mundo do software livre

O mundo do software livre (open
source) caminha hoje a passos largos.
Muitos sdo os programadores que se
dedicam a criar ferramentas dos mais
variados tipos sob esta definicdo. O
WinAVR é uma destas ferramentas,
que nasceu sobre a bandeira do soft-
ware livre. Trata-se de um compilador
para Linguagem C, que inclui em seu
pacote o compilador GCC GNU, para
a familia dos microcontroladores AVR
ATMEL.

Muitos acreditam que a principal
vantagem na utilizagéo de um software
livre esta na sua gratuidade. Claro,
esta é uma grande vantagem. Mas néo
se pode dizer que ela seja a principal.
A grande vantagem esta em poder
participar do projeto em si, fornecendo
informagdes que venham a melhorar
o programa e até mesmo realizando
alteragdes no mesmo.

Vantagens e desvantagens
do WinAVR

Saber sobre as vantagens e des-
vantagens do uso de uma nova ferra-
menta é sempre benéfico, pois permi-
tira ao desenvolvedor conhecer um
pouco mais sobre a mesma. Nao é
nossa intengao promover uma compa-
ragdo entre compiladores, mas apenas
fazer uma breve analise dos itens
considerados importantes para todo
e qualguer compilador. Na tabela 1
indicamos as principais vantagens e
desvantagens avaliadas pelo autor
do artigo.

Observando atentamente a tabela
1, pode-se notar que o nimero de
vantagens &€ bem maior que o nimero
de desvantagens. E mesmo estas
(as desvantagens) sdo passiveis de
solucionar.

Compilador C “gratuito” para
microcontroladores AVR

Microcontroladores

Marcio José Soares

O leitor pode perceber que algumas
das desvantagens demonstradas estéo
ligadas a falta de uma IDE, com mais
recursos. Porém, estes pequenos
inconvenientes podem ser facilmente
contornados. Junto com o pacote foi
fornecido um editor de texto, com bons
recursos para o gerenciamento do
projeto e compilagdo (necessario o
arquivo MakeFile).

Com relagdo a montagem do
arquivo MakeFile, o pacote traz um
aplicativo que permite criar de forma
bastante simples tal arquivo. Mais a
frente neste artigo o leitor recebera
dicas a respeito.

Com relagéao a falta de suporte
oficial em nossa lingua, isso também
nao é um agravante que impedira o
uso do compilador pelo leitor sem
conhecimento na lingua inglesa. Exis-
tem alguns grupos de debates na
Internet sobre o microcontrolador
AVR em nossa lingua. Nesses, muitos
participantes sao usuarios do WinAVR.
Participar de um destes grupos podera
ajudar. Para encontrar estes grupos
recorra aos sites que permitem a
criacdo de tais grupos. Um deles e o
Yahoo Grupos. Faga a busca usando
palavras-chaves “AVR”, “WinAVR”,
entre outras.

E claro, o leitor também podera se
valer de nossa revista. Muito em breve
traremos alguns projetos utilizando
os microcontroladores AVR em con-
junto com o compilador WinAVR.
Aguardem!

Observacao

E preciso compreender que para
participar do desenvolvimento
“open source” é necessario estar
cadastrado como desenvolvedor
junto a associagao de programa-
dores que iniciaram o projeto.
Além disso, toda e gualquer altera-
¢ao deve ser oferecida ao grupo
para que a mesma seja analisada
e inserida nas proximas versoes.
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IELEER

de microcontroladores).

~ avancados).
discusséo (em lingua inglesa).
inglesa) fornecida com o pacote.

‘uso do compilador.

- volvidos com a mesma.

Instalacao

O leitor deve estar neste momento
ansioso por usar o compilador. Vamos
entao comecar com os procedimentos
iniciais necessarios: download e insta-
lagdo. A versao do WIinAVR testada
e utilizada pelo autor é a 20060125. O
leitor podera fazer o download desta
versao em nosso sife na se¢ao down-
loads. Todos os testes apresentados
neste artigo foram feitos com esta
versao.

Trata-se de um arquivo executavel
(WinAVR-20060125-install.exe)
com um tamanho médio de 24 MB.
Assim, é recomendavel que o leitor
interessado possua comunicagac com
a Internet através de banda larga.
Caso contrario (conexao através de
linha discada) o download tera de ser
feito em horarios alternativos, visando
o melhor aproveitamento de sua linha
telefonica e ainda a melhor velocidade
de conexao.

Salve o arquivo em uma pasta tem-
poraria qualquer. Ao final do download,
execute o arquivo e siga as instrucoes.

- Tem excelente otimizagdo, mantendo uma boa
relagéo entre tamanho do cddigo-fonte e arquivo

final (a ser gravado no microcontrolador).

- A ofimizagdo também garante uma étima per-

- formance do cédigo-fonte / microcontrolador.

- Possui a definicAo open source e, portanto,
‘permite a partiCIpagéo no aprimoramento
da ferramenta de qualquer um que esteja
interessado (mdlcado apenas para usuarios

- Possui bom suporte através de um férum de

- Possui boa documentagao (manuajs em lingua

Vantagens Desvantagens

- O programa é fornecido gratuitamente, sem
~ qualquer restricdo com relagdo ao tamanho
~ do cédigo-fonte ou numero de dispositivos

(microcontroladores) admitidos para uso (lista

- Falta uma IDE (/ntegra-
fed Development Envi-
ronment) completa, com
recursos para gerencia-
mento de projeto, compi-
lagédo, simulagédo e gra-
vagdo. A ferramenta
utilizada e fornecida
no pacote (Program-

~ mers NotePad) permite
apenas a geréncia do
projeto e sua compilagao
através de um arquivo
MakeFile.

- A montagem manual do
arquivo MakeFile (assis-
tente de compilagao e
link-edicao) nao é das
mais faceis.

- Presenca de bibliotecas prontas para facilltar o - Falta de suporte oficial na

lingua portuguesa.

Tfata -se de uma ferramenta bastante difundlda
.,e_n_tre_ os usuarios do microcontrolador AVR e,
'."p'or_tanlo, muitos sao os projetos que podem
~ser encontrados na Internet que foram desen-

O aplicativo de instalacao é bastante
simples, mas muito inteligente. Basta
clicar em “Avancar” até a conclusao
da instalacao.

Apds a instalacao, o programa
criara alguns icones interessantes
(que também estardo disponiveis
no menu Iniciar, do Windows). Trés
desses icones trazem informacdes
interessantes a respeito do WinAVR
como o manual do mesmo, por exem-
plo. O estudo da documentagao ira
garantir maior sucesso no uso deste
compilador.

N&ao sera necessario configurar
nada neste momento. O aplicativo de
instalagao do WinAVR ja providenciou
as configuragdes necessarias para o
uso do compilador. Fécil, nao &7

Primeiro projeto

Para ajudar o leitor no seu primeiro
contato com o compilador nada melhor
que um passo-a-passo para um pri-
meiro projeto, orientando-o sobre:

- Criagao do projeto;

- Criagao do(s) arquivo(s) fonte para
o projeto;

- Geragao do arquivo MakeFile para o
projeto com o aplicativo MFile;

- Compilagao do projeto.

Criando o projeto com o
Programmers Notepad

Como dito anteriormente, o editor
de programas presente no WinAVR é
o Programmers NotePad. Trata-se de
um editor de textos muito interessante,
pois seus recursos foram focalizados
para o uso com compiladores.

Abra o aplicativo Programmers
NotePad. No menu File -> New ->
Project entre com os dados solicitados
(nome do projeto e subdiretério onde o
mesmo deve ser armazenado). Clique
em “OK". Veja a figura 1.

Mew Project...

= |

: R ;
Emply Project |

| |

Mame: | tuste_WinalR

Folder: ~ f]

Figura 1 - Gerando um projeto para o
WinAVR

E prudente o leitor separar seus
projetos em subdiretérios distintos. Isso
ajuda na manutencao do projeto além dos
backups. Deixaremos a organizacao de
tais subdiretérios por conta de cada um.

Agora o leitor podera ver na tela do
seu PC, najanela a esquerda intitulada
Project’, logo abaixo de New Project
Group, 0 nome dado ao seu projeto.
Pronto, o projeto esta criado (figura
2). Vamos adicionar um arquivo-fonte
para 0 mesmo.

Criando um arquivo para o
codigo-fonte

Para criar um arquivo-“fonte” use o
menu File -> New -> C/ C++. A janela
principal do Programmers NotePad
sera alterada conforme a figura 3.

O leitor precisa agora digitar um
programa. Sabemos que isso pode
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€ Programmers Notepad 2

© Fle View Tools Help

|| oo o] ¥R Eie

Tf';—'J Mew Project Group
[75) teste_WinAyR

rs Motepad 2 - [=new=]

P 3 Fle Fdic Vew Took Window Help LA
AL s YR o O BES] 0 W P -
| <news | 1 b X

L
| Mew Project Group !
‘ 3 tests_ WinAVR g

Figura 3 - Tela para digitar o programa

gerar alguns problemas, pois qualquer
erro cometido durante a digitagao
poderia impedir o leitor de realizar seu
primeiro teste com sucesso.

Assim achamos melhor inserir um
arquivo-fonte teste WinAVR.c

marque-o (selecéo total do arquivo),
copie e cole para a tela intitulada
New.

Em seguida salve o novo arquivo,
na pasta do projeto, atraves do
menu File -> Save As. Use o nhome

que achar mais adequado para seu
arquivo, mantendo a extensdo “.C”

em nosso site para ajudar. Abra este
arquivo com o Programmers NotePad,

mers Notepad 2 - [teste_winAVR.c] |
i 3 Bls Edt Yiew Tools Window Help &

W o A ¥ Jored =

(AP W o xDT '
lgcte_wlnh\m.cl =

T L e T o L e e

(52 Mo Project Group
= [ teste_wnam
[ teske winavR.c

o principal - MAIN
A A R R O Al e el e

Eint mad nivoid){

DDRA = (xFE; £ po
PORTA = Ox0L; L

DORE =
PORTE =

PORTB = OxOL;
while (TRUED{

| Af (PINA & ox01){
‘ i celay();
if (PORTE < 0x80)
| PORTB = PORTBE << Ox01;
else{
| delay();
PORTE = 13

}
1 elsef
delay(d;
if (PORTE > Ox01)
PORTE = PORTE »>» Ox0l; //faz deslocamarto do bit

| b
|
T

| [ A Pl elsef ’
i delayld: Jitemporiza
| PORTE = Ox80; AAAnicia novamente
}

}

recurn (2);

Figura 4 - Arquivo fonte inserido no projeto
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(nome do arquivo.c). Evite nome
com espagos e caracteres especiais.
Use como exemplo o nome dado para
nosso exemplo.

Apds salvar o arquivo é hora de
inclui-lo ao projeto. Cligue com o botédo
direito sobre o nome do seu projeto, na
janela Projects e em seguida selecione
o arquivo (que deve ser exatamente o
que estd aberto na tela do aplicativo
e salvo no subdiretério do projeto). Se
tudo correr bem, a tela do Program-
mers NotePad se parecera com a
figura 4.

Gerando o arquivo Makefile
com o aplicativo Mfile

O leitor precisa agora gerar o
arquivo MakeFile. Este arquivo sera
empregado para a compilagédo do
codigo-fonte e link-edigdo com bibliote-
cas. Para os usuarios e programadores
em ambiente Linux, o uso deste tipo
de arquivo ndo é mais' segredo, mas
0 mesmo é pouco comum para os
usuarios do Windows.

Junto com o WinAVR foi instalado o
aplicativo Mfile [WIinAVR]. Este permite
gerar de forma rapida e segura o
arquivo MakeFile. Abra este aplicativo
através do icone criado na area de
trabalho do Windows, ou ainda através
do menu “Iniciar’. Ele se apresentara
como na figura 5.

Insira 0 nome do arquivo main a ser
compilado através do menu MakeFile
-> Main File name.\océ devera digitar
o nome do seu arquivo-fonte principal.
No caso do leitor utilizar o arquivo
fonte fornecido pelo autor, 0 nome do
arquivo serd teste_winAVR sem a
extensao “.C". Nao insira a extenséo
citada! Veja a figura 6.

O Mfile, imediatamente apds a
confirmagao do nome do arquivo, ira
inserir o nome digitado no arquivo
MakeFile que € mostrado em sua
tela (PC). Sempre que uma alteragéo
for feita no arquivo, a mesma sera
demonstrada.

Em seguida, selecione a CPU
(microcontrolador) no qual vocé vai
gravar o programa. Nosso exemplo
foi desenvolvido para o microcontro-
lador ATMEGA16. Para selecionar o
microcontrolador indicado use o menu
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File  Makefile

Help File  Makefile

=11

Help

# Hey Emacs, this is a -* makefile -*
.

1t Released to the Public Domain
#

# Additional material for this makefile was wiitten by:
H Peter Fleury

# Tim Herigan

# Colin O'Flynn

# Reiner Patommel

# Markus Pfaff

# Sander Pool

# Frederik Rouleau

# Carlos Lamas

.
# On command fine:
#

# make all = Make software,
# make clean = Clean out built project files:

# make coff = Convert ELF to AVR COFF.
#

{

# WindWR Makefile Template written by Eric B. ‘Weddington, Jorg Wunsch, et al.
#

- # Hey Emacs, this is a - makefile -*- Rl
#

# Peter Fleury

# Tim Henigan

# Colin OFlynn

# Reiner Patommel
B Markus Praff

# Sander Pool

# Frederik Rouleau
# Carlos Lamas

~=4

B 'WindVR Makefile Template written by Eric B. Weddington, Jarg Wunsch, et al
#

# Released to the Public D omain

#

# &dditional material for this makefile was written by:

Main file: {teste_WindVR

|.

Mainfile (=] [X]

ok

; On command line:
#

#

| L <

# make all = Make software,
1t make clean = Clean out built project files.

#
# make coff = Convert ELF to &R COFF.
#

Figura 5 - Janela principal do Mfile

MakeFile -> MCU Type -> ATmega
-> atmega16é.

Salve o arquivo no subdiretdrio
do projeto sem alterar seu nome
(Makefile) usando o menu File -> Save
As. Feche o aplicativo Mfile. Vocé nao
precisara mais dele.

Compilando o projeto

A esta altura o leitor ja tem um
projeto pronto para ser compilado.
A compilagdo do mesmo é bastante
simples e feita através do editor Pro-
grammers NotePad, menu Tools -
[WinAVR] MakeAll. Se tudo correr
bem, na janela Oufput sera apresen-
tada uma mensagem conforme mostra
a quadro 1.

A informagao Exit Code: 0 é impor-
tante. Com ela, o leitor podera saber
qual erro ocorreu durante a compilagéao
do seu projeto. O codigo “0” informa
que a compilagdo foi um sucesso.
Para confirmar isso, basta abrir o
subdiretério do projeto e verificar
a presenga do arquivo nome do
arquivo_ fonte.HEX. O arquivo
HEX € o resultado da compilagao.
E este arquivo que sera gravado no
microcontrolador.

Como curiosidade o leitor podera
abrir 0 arquivo nome _do _arguivo
_fonte.lss que contém a “conver-

sdo” das instrugdes da linguagem
C para a linguagem Assembly. A
grande maioria dos compiladores C
desenvolvidos para microcontrolado-

Figura 6 - Nome do arquivo a ser compilado

res gera tal arquivo (as vezes com
extensoes diferentes).

Este arquivo ajuda o desenvolvedor
a “medir” o grau de otimizagao do

Quadro 1 - Mensagem de compilagao

> “make.exe” all

~~~~~~~~ begin ====-----

avr=gec GEEN 3.5

Copyright (C) 2004 Free Software Foundation, Inc.

This is free software; see the source for copying conditions.
There 1s NO warranty; not even for MERCHANTABILITY or
FITNESS FOR A PARTICULAR PURPOSE.

Size before:
AVR Memory Usage

Device: atmegalb

Program: 238 bytes (1.5% Full)
(.text + .data + .bootloader)
Data: 0 bytes (0.0% Full)
fodata- 4 bess + snoinit)

Size after:

AVR Memory Usage

Device: atmegalé

Program: 238 bytes (1.5% Full)

(.text + .data + .bootloader)

Data: 0 bytes (0.0% Full)
{.data + .bss + .noinit)

———————— =ik St i b
> Process Exit Code: 0
> Time Taken: 00:01
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Figura 7 - Circuito de teste

compilador e é util para encontrar um
bug do compilador ao “traduzir” um
determinado comando da linguagem
Cpara a Linguagem Assembly. E claro
que para estes casos sao necessarios
conhecimentos em ambas as lingua-
gens de programagao.

Circuito de testes

Na figura 7 o leitor tem um circuito
para testar o programa oferecido
em nosso site. O circuito possui um
display tipo “barra de LEDs" com 10
segmentos (utilizamos apenas 8).
Porém o leitor que néo possuir tal
componente em sua bancada, podera
utilizar oito LEDs comuns no lugar
de cada segmento, sem nenhum pro-
blema.

Nossa sugestdo é que o circuito
seja montado em uma matriz de con-
tatos (figura 8). Nao oferecemos o
lay-outpara a confecgao de um circuito
impresso, pois o intuito do artigo nao foi
mostrar uma montagem, mas sim um
passo-a-passo para uso do compilador
WinAVR.
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6 pB5MOSI LL 1000
; PBE/MISO AVCC%E-"
PB7/SCK ABEEF=—
ATMEGA16

Ap6s a montagem do circuito o
leitor devera gravar o microcontrola-
dor. Para isso recomendamos 0 uso
do gravador ET-AVR1, publicado na
edigdo n?113, em conjunto com o
programa PonyProg. Todas as informa-
¢cOes necessarias sobre a montagem
do gravador e seu uso em conjunto
com o programa PonyProg foram pas-
sadas no referido artigo (edi¢do 113)
e, portanto, ndo serédo aqui novamente
descritas.

Figura 8 - Aspecto de montagem

Microcontroladores

Para os leitores sem conhecimento
na Linguagem C, aconselhamos
a leitura da série “Linguagem C”
publicada entre as edigbes 98
e 103 desta revista. Nesta série
abordamos os fundamentos da lin-
guagem C, passando informagdes
e dicas importantes para o uso da
linguagem tanto em PCs como em
microcontroladores. Esta mesma
série foi também publicada na
revista Saber Eletrénica Especial
CD n211 em formato digital (arqui-
vos PDF). O leitor interessado

podera saber mais sobre estas
as dicas em nossa loja virtual

www.sabermarketing.com.br.

Conclusao

A leitura (e por qué nao releitura?)
deste artigo permitiréd a fixacao dos
passos necessarios no uso inicial do
compilador e suas ferramentas. Esta
também ajudara a sanar duvidas
que, por ventura, possam surgir. Uma
boa documentagéo esta presente no
subdiretdrio de instalacao do WinAVR
e recomendamos sua leitura também
(dentro do possivel). Com um pouco
de préatica e dedicagéao, o leitor estara
muito em breve utilizando o compilador
WInAVR com bastante facilidade. Até
a proxima! T

www.eletronicatotal.com.br

Acesse no site da revista o arquivo
WinAVR-20060125-install.exe

WinAVR :

http://winavr.sourceforge.net/

Open Source -
http://www.opensource.org/

GNU - hitp://www.gnu.org/

Grupos de usudrios
http://www.yahoogrupos.com.br
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O objetivo deste artigo
é fornecer ao leitor algumas
montagens praticas, que resul-
tarao em bons dispositivos eletro-
nicos para seguranca, desde simples
aplicacoes com um relé até um médulo
distribuidor de alimentacao para CFTV.
Alguns conhecimentos teoricos e praticos serao
fundamentais para levar a cabo estas montagens,

Montagens praticas

seglikanca

de modo que aconselhamos o leitor a buscar tais
conhecimentos, caso nao os possua.

RELE

O relé é um dispositivo eletromeca-
nico que tem como fungéo controlar a
abertura, fechamento ou comutacao
de contatos elétricos que acionam/
desacionam dispositivos elétricos
como, por exemplo, sirenes, lampadas,
motores, etc... Quando a corrente
elétrica percorre a bobina do relé, um
campo eletromagnético € gerado e faz
surgir uma atragdo magnetica sobre
as laminas (armaduras) compostas de
contatos elétricos. Os contatos podem
assumir alguns estados, dependendo
da forma como sao montadas as
laminas, entdo podem ser: NA (nor-
malmente aberto), NF (normalmente
fechado) ou de comutacao (reversi-
vel).

As principais caracteristicas do relé
dizem respeito a:

Alimentacéao: Pode ser energizado
com corrente bem menor em relagéo
a corrente circulante no dispositivo
que ira controlar.

Isolamento: Nao ha contato elé-
trico entre o circuito da bobina e suas
laminas, ou seja, ndo circula qualquer
corrente elétrica entre eles, permitindo
que sejam comandados dispositivos
que funcionem com alta tensao, ofere-
cendo seguranga na operagao.

Existem muitas formas de aplicar o
relé, no entanto, mostraremos alguns
exemplos de aplicagédo em centrais de
alarme, cuja fungéo principal € acionar
dispositivos de sinalizagao auxiliar
(sirene piezelétrica, lampada, sirene
eletromecanica, etc.). O tamanho do

Pedro A. Medoe

relé e suas caracteristicas técnicas
estédo relacionados diretamente com
sua tensdo de alimentagao e corrente
maxima que iré circular pelos seus con-
tatos. Em centrais de alarme o dispositivo
auxiliar que consome mais energia
elétrica é a lampada de emergéncia.

Supondo que seja instalada uma
lampada de 100 W, ligada em 117 VAC,
ela consumira uma corrente de 0,854
A e, portanto, um relé comercial de
12V/5A para circuito impresso, faciimente
encontrado nas lojas de componentes
eletronicos, atendera a necessidade.

A forma ideal para ligar o dispositivo
ao relé é através de uma placa de circuito
impresso. Desta forma, a instalagéo
apresentaréa um aspecto mais profissio-
nal. Ha no mercado diversos kits com os
materiais necessarios para a confeccao
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de circuitos impressos. Um desses kits é
o conjunto CK-10, que pode ser encon-
trado no site www.sabermarketing.
com.br. Idealizamos o /ayout de uma
placa para alojar o relé e conectores que
interligam outros dispositivos.

A figura 1 mostra o esquema e o
layout da placa de circuito impresso.
Sua confecgdo sera util para montar os
diversos exemplos que mostraremos
a seguir:

Sirene piezelétrica auxiliar

O diagrama para a instalagéo de
uma sirene piezelétrica auxiliar com
alimentagéo prépria é indicado na
figura 2. Os passos para sua ligagéo
sdo:

IR Se ja houver uma sirene instalada,
desconecte seus fios da central de
alarme;

A Interligue a placa montada com
o conector da central de alarme por
intermédio de um cabo polarizado,
ou, com fios nus solidos de maneira
que a placa fique junto a barra de
terminais da central. O conector CN;
é utilizado para fazer essa conexao,
e, ndo se esquecga de verificar a
polaridade correta;

BER Ligue a sirene da central em
CN2;

KA Ligue os fios da bateria auxiliar
no conector CNg, atengao para a
polaridade;

A Ligue os fios da sirene auxiliar no
conector CNy.

Quando a central de alarme dispa-
rar, o relé sera também acionado pela
presenga da alimentacéo (12 VDC) no

CIRCUITO ELETRICO
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Figura 1 - Esquema elétrico e layout do circuito impresso

conector CN4, este por sua vez ficara
acionado enquanto a sirene estiver
tocando, disparando ao mesmo tempo
a sirene auxiliar que é alimentada por
uma bateria propria.

AQ CONECTOR DA SIRENE

- +

..... Slan gt oy
! ]
! 1
I CN1 |
! ]
I n__n 1
! 1
! 1
- TRl O | |
L) 2 '
i 9 ReLe |,
SIRENE | I
PIEZO ' ;
: o o L} o o :
! |
il CN3 CN4 !
! XL L KL _I

SIRENE

PIEZO
AUXILIAR
BATERIA
AUXILIAR [*

Figura 2 - Sirene piezelétrica auxiliar
Sirene eletromecanica

O diagrama para a instalacéo de
uma sirene eletromecéanica com ali-
mentacao prépria é indicado na figura
3. Os passos para esta montagem
sao: ;

IERRepita os procedimentos 1 e 2 da
instalagao anterior;

BEALigue a rede elétrica no conector
CN3. Tome todas as precaucdes para
nao levar choque! Se nao tiver expe-
riéncia, procure ajuda de alguém
experiente;

Ligue os fios da sirene
eletromecénica no conector
CNy.

Automacao Predial

O funcionamento é semelhante ao
caso anterior, porém com um disposi-
tivo alimentado por energia elétrica
comercial (110 ou 220 VAC). Nao
esqueca de verificar qual é a tensao
correta de funcionamento da sirene
eletromecénica que vocé esta insta-
lando.

AO CONECTOR DA SIRENE

1 1
[ 1
! ]
1 CN 1 i
I
| n o :
! I
! ]
i T 0 |5 I
+ 8 !
Tl™ 19 ree ||
SIRENE | [
PIEZO | /
: 1* ] o o L") o :
! ]
| eN3 CN4 |t
Il Bl 151 [L i~ Il !
SIRENE
ELETR.
AUXILIAR
REDE
ELETRICA

Figura 3 - Sirene eletromecanica

Lampada de emergéncia

O diagrama para a instalagéo de
uma lampada de emergéncia com
alimentacgao propria é indicado na
figura 4. Os passos para sua ligagéo
sao:

M Repita os procedimentos 1 e 2 do
primeiro exemplo;

A Ligue a rede elétrica no conector
CNj. Cuidado para nao levar
choque!

[ [ |
ON 1
[|'2
el RELE
‘ oy ove | ons
L —--—I |_f‘| n n n
LADO
DA SOLDA LAY-OUT
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] ] Rl | -1 -
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PIEZO i :
: o o 1=} o 1* | :
! 1
| CN3 CN4 !
: B KL o - _n_ _I
LAMPADA
DE
EMERG
REDE
ELETRICA

Figura 4 - Lampada de emergéncia

BEA Ligue os fios da lampada de
emergéncia no conector CNy,

Cerca monitorada

O diagrama para a instalagéo de
uma cerca monitorada (atengéo: nao
é uma cerca eletrificada!) com alimen-
tacao da central de alarme € indicado
na figura 5. Os passos para sua
implementacgéo sao:

IE® Com um cabo polarizado leve a
alimentagéo de 12 VDC disponivel
na saida Aux. da central de alarme
até CNy e CNj (positivo e negativo
respectivamente);

A Ligue um dos fios provenientes da
cerca em CN,, na posigéao indicada.
Atencao, caso voce ligue no terminal
errado a fonte entrara em curto!

BEA Ligue o outro fio proveniente da
cerca em CN,, conforme mostrado;

A Ligue os fios provenientes da zona
de protegao da central respectivamente
em CNg5 e CNy, conforme ilustrado.

O funcionamento nessa configura-
¢do é o seguinte: Uma alimentacéo de
12 VDC é disponibilizada na bobina
do relé através da cerca, ou seja, a
fiagao da cerca e a bobina do relé estao
ligadas em série. Se a cerca for cortada
a corrente sera interrompida e o relé
desarmara, provocando abertura em
seu contato NA que estava fechado.
Como os contatos do relé fazem parte
do circuito de sensores que estao
ligados na zona sob protecao, o alarme
da central sera disparado.

SAIDAAUX. ZONA
i o T
j CN 1 l [
: : Q
I I [ =
| . g
T 2 : 8 [®
I
Uil RELE | ol
! 1
i : (0] (O
1 | =
1
i : 5l |s
' cN3 CN4 |1 gl |2
1 | -

- Tl ==
gl [ nF T"’

NA
CERCA [

Figura 5 - Cerca monitorada

Bem, a essa altura o leitor podera
indagar: Por que até agora o contato
NF gue esta em CN, nao foi utilizado
para nada? A resposta & a seguinte:
Vocé podera usar esse contato numa
configuracao de montagem diferente
das apresentadas até agora como, por
exemplo, sinalizar com uma lampada
ou acionar uma sirene quando a cerca
for cortada.

Instalacao de sirene a
longas distancias

Uma situagao que podera ocorrer
¢ quando for necessario ligar uma
sirene a uma longa distancia da
central de alarme. Para tal serdo
requeridos dois circuitos, ou seja,
duas placas de circuito impresso deve-
rao ser confeccionadas. O esquema
de interligagdo das placas é apresen-
tado na figura 6.

CABO PARALELO POLARIZADO
DE LONGA DISTANCIA

2x0,75 mm2

MODULO DISTRIBUIDOR

Uma forma eficaz de distribuir a
energia elétrica que ira alimentar came-
ras de CFTV ou até mesmo alguns
acessorios é fazé-lo através de um
maddulo contendo varias saidas. Tal
pratica € muito utilizada em varios paises
da Europa e principalmente nos Estados
Unidos. Elaboramos o MDA (Mdédulo
Distribuidor de Alimentagéo), modelo
com 4 saidas, o0 MDA-4F. Suas saidas
sdo comuns e protegidas por fusiveis
e monitoradas por LEDs, seu circuito é
exibido na figura 7. O modulo converte
sua entrada de alimentagéo DC ou AC
em saidas paralelas, que serviréo para
alimentar os dispositivos eletrénicos
utilizados no sistema de seguranca.

Caracteristicas

Pode ser instalado numa caixa
metalica de uso interno ou externo,
permitindo que a alimentagao prove-
niente da fonte seja disponibilizada
com cabos de bitola maior, diminuindo
assim a queda de tenséo até o ponto
de distribuicdo. Prever na caixa meta-
lica, furos falsos para a instalagao
de eletrodutos. Os conectores séao
robustos e aceitam cada um até dois
terminais tipo “Y” para cabos flexiveis
com bitola 6 mm2. Uma chave liga/
desliga permite ao instalador efetuar
manutengao nos dispositivos conecta-
dos ao modulo sem a necessidade de
desligar a alimentacao principal.

Especificacoes Técnicas
« Saidas: protegidas com fusiveis;
« Tensdao maxima de entrada:
30 VAC/VDC;

I: - J-, CONECTOR DA

CENTRAL

J CENTRAL

-
SIRENE NA e BATERIADA

Figura 6 - Instalago de sirene a longas disténcias

BATERIA l SIRENE

AUXILIAR T+ i :H

+
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kMFixe o MDA-4F em local desejado;
M Coloque a chave S¢ na posicdo DES;
IEMConecte os fios da fonte de alimentagéo (bateria,
transformador ou fonte DC) no conector CNy, (figura
8) numa das seguintes maneiras:
« Caso a alimentagdo for de corrente continua
(bateria ou fonte DC), o pdlo negative devera ser
conectado em ON (terminal esquerdo) e o polo
positivo em OP (terminal direito);
* Se a polaridade estiver correta, LP devera acender
com a cor verde, se estiver invertida a cor sera
vermelha, neste caso inverta os fios;
* Caso a alimentacao for de corrente alternada
(transformador), ndo ha polaridade fixa para os
fios, portanto fixe-os um em cada terminal. A cor
de LP sera laranja (vermelho + verde);
I3 Mude a posicao da chave Sy para LIG. Todos os
33 LEDs das saidas deverédo acender;

; FONTE
Figura 7 - Esquema do | P
modulo distribuidor

* Entrada: monitorada com LED, com indicagdo de AC, DC i e o :
ou polaridade invertida; =y P
* Saidas: monitoradas individualmente com LEDs; CABOS COM

» Chave liga/desliga: incorporada na placa. Flalmied | Bl |BITOLAMAIOR

1N4148

Instalacao do MDA-4F

Os passos para instalagao sao:

o 0!

PLACADE PLACA DE

SENSOR SENSOR

Figura 9 - Layout da placa de circuito impresso
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DISTRIBUIDOR
COM 4 SAIDAS

FONTE DE
ALIMENTACAO

CABOS COM
BITOLA 2,5 mm
Phaa s

s

CAMERAS

{de alta poténcia)
PROXIMAS DA
FONTE

CAMERAS
(de média poténcia)

DISTANTES DA
FONTE

CAMERAS
{de média poténcia)

DISTANTES D
INTE

CAMERAS

(de babxa poténcia)
DISTANTES DO
Médulo 1

FONTE DE
ALIMENTAGAO

CABOS COM
BITOLA 2.5 mm

(de alta poténecia)
PROXIMAS DA
FONTE

MDA-4 B
(Mébdulo 2)

CABOS COM

BITOLA 1,5 mm s

T PEOES
CELEETE

CREILE S
ar

Cats

onvém medir a tenséo presente
numa das saidas (1P~1N a 4P~4N)
antes de conectar os fios de alimen-
tacdo dos dispositivos, para um
eventual ajuste.

Observacdo: Se a alimentagéo for
de corrente continua, o sufixo P (OP,
1P...4P) indica terminal com polaridade
positiva; o sufixo N (ON, 1N...4N) indica
terminal com polaridade negativa.
B} Conecte os fios dos equipamen-
tos.

Figura 11 - Utilizando dois médulos em cascata

Fusiveis

Adapte os fusiveis (corrente
maxima) de acordo com as carac-
teristicas de consumo dos equipa-
mentos que estiver alimentando.

Circuito impresso

A figura 9 sugere um /ayout
para a placa de circuito impresso

do MDA-4F, lembrando que as trilhas
mais largas devem ser estanhadas, pois a
corrente através delas sera maior.

Exemplos de aplicacao

A figura 10 demonstra uma instalagao
onde o MDA-4F recebe alimentagao DC
proveniente de uma fonte que supre o
fornecimento de 6 cameras. As cameras 1,
2 e 3 estdo mais préximas do suprimento,
ja as cameras 4, 5 e 6 estdo mais distantes.
Assim, é possivel alimentar cameras
mais distantes por intermédio do mddulo
distribuidor, ligando a sua entrada um par
de cabos com bitola maior e conectando as
saidas do médulo os cabos que alimenta-
rao essas cameras.

Outro exemplo € o da figura 11, que
adequa dois médulos em cascata (para-
lelo), o segundo sendo alimentado por
cabos de menor bitola do que o primeiro,
uma vez que distribuira a alimentagéo
para cdmeras que consomem correntes
menores.

Caixa metalica

A forma mais simples de alojar o médulo
é fazé-lo numa caixa metalica de sobrepor.
Uma sugestéo é dada na figura 12, onde
estdo indicadas as medidas em milimetros
e os furos cegos laterais de 3/4” para
conexdo de eletrodutos.

Figura 12 - Sugestdo de caixa

Observacoes finais

EMUma saida protegida podera alimentar
um ou mais dispositivos;

IEAEspecifique os fusiveis de acordo com
as cargas consumidas;

BE} Utilize somente fusiveis de agéo
répida. T
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Matematica

Logaritmos

Na eletronica, em varias ocasioes, nos
deparamos com equacoes onde os logarit-
mos devem ser calculados. Um exemplo
muito comum é no calculo do ganho de um
sistema. Alguns sabem calcular os logaritmos
e quais sao suas propriedades, mas poucos
entendem o conceito de logaritmo e o que
significa essa ferramenta matematica.

0 que sao os logaritmos?

No século XVII o surgimento de
matematicos, filésofos e fisicos era
grande. Novas teorias nasciam a todo
o momento. Johannes Kepler (1571 —
1630), com suas teorias das o¢rbitas
dos planetas, era um destes filésofos-
matematicos. Ele se deparou com
equagdes exponenciais, grandes e de
resolugdo complexa. A capacidade
de célculo da época e as ferramentas
matematicas existentes nao permitiam
a rapida resolugao dessas equacgodes,
0 que tornava esses calculos um
verdadeiro martirio.

Neste ambiente, John Napier (1550
—1617), escreveu uma obra que revo-
lucionou a matematica e permitiu a
solugdo dessas equagbes complexas
em muito menos tempo e de modo
muito mais simples. Seu principal
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livro foi o “Mirifice Logarithmorum
Canonis Descriptio” (1614), cuja
tradugdo seria “Uma maravilhosa
descrigdo das leis da evolucdo”.
Sim, o conceito de logaritmo desen-
volvido por Napier mostra a evolugdo
de um numero para outro nimero.
Como assim?

Ao comecar a calcular numeros
exponenciais, Napier percebeu uma
propriedade implicita. Veja por exem-
plo poténcias utilizando a base 10,
mostradas na equacéao 1:

Equacéo 1 - Poténcias de base 10

400wt

10'=10 &8
10%= 10;('& 100

10%=10x 10 x 10 = 1000
10*= 10 x 10 x 10 x 10 = 10000

Alessandro F. Cunha

Note que o expoente 1 resulta no
nimero 10, o expoente 2 resulta no
numero 100, o expoente 3 resulta no
numero 1000, e assim por diante. Pen-
sando desta maneira, Napier organizou
os numeros de um modo diferente,
como a mostra a tabela 1.

Napier observou a existéncia de
uma correlacao entre a linha de “ntime-
ros” e a linha de “expoentes”. O nimero
40, por exemplo, esta entre os numeros
10 e 100. Se o expoente 1 gera o
numero 10 e o expoente 2 gera o
numero 100, existe um expoente entre
1 e 2 que ira gerar o nimero 40. Para
provar esta suposi¢éo, Napier fez mais
alguns célculos, o que resultou na
tabela 2.

Nesta nova tabela foi possivel
perceber que o numero 40 esta entre
os numeros 39,81 e 50,11. Estes, por
sua vez, sao gerados pelos expoentes

27
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Tabela 2 - Evolugédo dos numeros na base 10 através dos expoentes de 1,0 até 2,0.

1,6 e 1,7. A correlagéao ainda se man-
tinha e notou que se criasse uma nova
tabela com valores de exponenciais
de 1,60 até 1,70 se aproximaria ainda
mais do numero 40. Napier fez isso
mais algumas vezes. Ao final destas
observagoes ele escreveu:

Logarithmorum 40
basis 10 aequalis 1,602059...

Cuja tradugao do latim é:
A evolugdo do numero 40

na base 10 é igual a 1,602059...

E que se aprende na escola como
& mostrado na equagao 2.

Equacao 2 - Logaritmo de 40 na base 10
log,, 40 = 1,602059... :

Sim, para John Napier, um nimero
evoluiu de uma escala (numeros reais)
para outra escala (logaritmica). Isso
significa dizer, matematicamente, o
que é mostrado na equacao 3.

Equacao 3 - Exponencial de 10

que gera o numero 40

101,802069‘,, =40

Isto é valido para qualquer base.
Veja o exemplo dado na tabela 3,
com a base 2, para obter a evolugéo
(logaritmo) do nimero 40.

O numero 40 esta entre os nume-
ros 32 e 64, que sdo gerados pelos
expoentes 5 e 6. Fazendo uma nova
escala de expoentes de 5,0 até 6,0
tem-se a tabela 4.

Agora o numero 40 esta entre
os numeros 39,39 e 42,22, Estes
sdo gerados pelos expoentes 5,3 e
5,4. Extrapolando essa idéia, Napier
escreveria:

Logarithmorum 40 basis 2
aequalis 5,321928...

Cuja tradugéao do latim é:

A evolugédo do numero 40 na base 2
é igual a 5,321928...

A notacao da escola é a da equa-
céo 4.

 Equacéo 4 - Logaritmo de 40 na base 2
log, 40 = 5,321928...

Seu contraponto exponencial e
mostrado na equacéo 05.

Equacao 5 - Exponencial de 2

que gera o niumero 40
05321928... _ 40

Qual a importancia disto?

Ao ler o artigo até aqui, vocé leitor,
deve estar se perguntando: e dai? Para
que serve esta mudanga para uma
escala logaritmica, esta tal “evolugéo”
de um numero?

Aqui esta a grande, e genial, des-
coberta de John Napier: perceber que
mudar um numero para uma escala )
logaritmica permite que as operagoes
matematicas sejam mudadas também,
simplificando os célculos. Calma, i
eu explico. Se vocé pensar em
termos exponenciais vai compreender
algumas propriedades interessantes.
Pense na multiplicagdo de numeros
gerados por exponenciagbes, como
na equacéao 6.

.

Equacdo 6 - Calculo exponencial

22x24=224-26-64

Se ao invés de escrever uma base
e seu expoente, fossem utilizados os
numeros que resultam destes calculos,
teriam o mesmo resultado, fornecido
na equacao 7:

Equacéo 7 - Calculo de multiplicacao

4x16=64

Napier reparou que a propriedade
de soma exponencial também se aplica
a evolucao dos nimeros, ou seja, aos
logaritmos. Onde antes era necessario
fazer uma multiplicagao, passou-se a
fazer apenas uma adigéo, operagao
matematica muito mais simples de
executar, como mostra a equacao 8.

AR DM BR800

51|52 ] 53

15,4 |

55 1868 157 | 58158160

Tabela 4 - Evolucdo dos numeros na base 2 através dos expoentes de 5,0 até 6,0.
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Equacao 8 - Multiplicacao

transforma-se em adigao
log,(4) + I0g,(16) = log,(4 x 16)» NI

Essa caracteristica foi testada
para todas as outras operagoes, e
se chegou a concluséo mostrada na
tabela 5.

Um célculo de multiplicagao com
numeros transforma-se em soma com
logaritmos. Um calculo de divisao vira
subtragdo. A potenciacédo passa a ser
multiplicagéo e a radiciagao sera feita
através de divisao.

Em uma época em que as maqui-
nas de calculo ainda nao haviam sido
inventadas, isto reduziu (e muito)
o tempo necessario para resolver
complicadas equagées.

Aplicacoes em Eletronica
Nao importa qual é a base utili-

zada: sempre uma fungéo logaritmica
(equacao 9) tem uma curva com a

caracteristica mostrada na figura 1,
que mostra uma propriedade interes-
sante: nao importa qual é a base, a
curva sempre passara pelo ponto (x
=1, ¥=0)

Equacdo 9 - Funcao logaritmica

f(x) =log, (x)

Diversos componentes na eletro-
nica tém comportamento logaritmico,
como é o caso da carga de capacito-
res, da reatancia indutiva, etc. O som
também é percebido por nossos ouvi-
dos através de uma escala logaritmica.
Assim, alguns controles de volume,
feito através de potencidmetros, devem
ter escala logaritmica.

No préximo artigo abordaremos
uma importante aplicagéo dos logarit-
mos: o decibel (dB). Até |a. T

*Alessandro F. Cunha é engenheiro elétrico,
trabalha em Telecomunicagées desde 1994 e
é professor da rede SENAI.

Base 10

- Base 4,5
Base 3

Céleulo
com numeros

. aaa..a
: R e

Vet B

Célculo com logaritmos

~ Blog(a®)
A109 @) oggr7)

Tabela 5 - Regras de calculo com logaritmos
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Os datasheets ou folhas de especificagoes de componentes

sao os documentos mais consultados pelos profissionais de
Eletronica. Neles, encontramos todas as informagoes que
nos permitem usar corretamente um componente. Como
interpretar os textos de forma correta e como escrever
um datasheet, caso o leitor necessite em algum dia, é
algo de que trataremos aqui em nosso “Inglés aplicado

a Eletronica”.

grande maioria das folhas de
A dados (datasheets) dos com-

ponentes eletrénicos esta em
inglés. Podemos obter essas folhas
impressas a partir de CDs, ou fazendo
o download a partir dos sites de fabri-
cantes e outros na Internet.

No entanto, o maior problema para
muitos dos leitores € que essas folhas
de dados estdo em inglés, o que
pode significar alguma dificuldade
de tradugdo se o leitor nao dominar
perfeitamente esse idioma.

O inglés comum & bem diferente
do inglés técnico, onde os jargoes
e as expressoes idiomaticas séo eli-
minados em prol da clareza e exatidao

das informacotes contidas. Contudo,
mesmo seguindo essa estrutura, o
problema maior esta justamente no
uso de termos técnicos que o leitor
precisa conhecer.

Para que o leitor se familiarize
bem com esse tipo de documento,
escolhemos um texto que é a abertura
de um datasheet de um componente
bem conhecido, na forma original
fornecida pelo seu fabricante.

Texto de um DataSheet:
“1 M350

3.0 A, Adjustable Output, Positive
Voltage Regulator

Newton C. Braga

The LM350 is an adjustable three-
terminal positive voltage regulator
capable of supplying in excess of 3.0
A over an output voltage range of 1.2
V to 33 V. This voltage regulator is
exceptionally easy to use and requires
only two external resistors to set the
output voltage. Further, it employs
internal current limiting, thermal shut-
down and safe area compensation,
making it essentially blow-out proof.
The LM350 serves a wide variety of
applications including local, on card
regulation. This device also makes an
especially simple adjustable switching
regulator, a programmable output
regulator, or by connecting a fixed
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LM350

D A B T O A = WA BT T

3.0A, Adjustable Output,
Positive Voltage Regulator

The LM350 is an ﬂLleIbldb!L three—terminal positive voltage
regulator capable of supplying in excess of 3.0 A over an output
voltage range of 1.2 V to 33 V. This voltage regulator is
exceptionally easy to use and requires only two external resistors to
set the output voltage. Further, it employs internal current limiting,
thermal shutdown znd safe area compensation, making it essentially
blow-out proof.

The LM350 serves a wide variety of applications including local,
on card regulation. This device also makes an especially simple
adjustable switching regulator, a programmable output regulator, or
by connecting a fixed resistor between the adjustment and output, the
LM350 can be used as a precision current regulator.

ON Semiconductor”

htlp llonsemi.com

THREE TERMINAL
ADJUSTABLE POSITIVE
VOLTAGE REGULATOR

TO-220
T SUFFIX
Sk u PLASTIC PACKAGE
® Guaranteed 3.0 A Output Current CASE Z21A
® Output Adjustable between 1.2 V and 33 ¥
» Load Regulation Typically 0.1%
® Line Regulation Typically 0.005 iu.\ b i
¢ |nternal Thermal Overload Protection 2 Vg
# Internal Short Circuit Current Limiting Constant with Temperature 3 3V
* Output Transistor Safe Area Compensation
® Floating Operation for High Voliage Applications Hamtuink surface is connectad to Pin 2.
® Standard 3-lead Transistor Package T ——————
® Eliminates Stocking Many Fixed Voltages MARKING DIAGRAM
® Pb-Free Packages are Available*
Vi Vou O
. [TEY
LM
sh 30T
M0 JAWLYWW]
bl | | acgust 5
Ciy — Og*
T o ™ W LJQU
A.FH, = Asssmbly Location
\HL = Wafer Lot
Y = Year
b WW = Work Week
-

* =, & maurad § mguinkor is focated an appmcabie datanos from power supply Siler

* - o & nof neadad for stablity, however, il doas mprove ranser respons.

R
Ve = 1av[1+ﬁ$ + lag

Rg

ORDERING INFORMATION
Sea dataled ordering and shipphg RormeEton N he packags
dimersions saction on page 3 of s data sheet.

el i conolled bo hoss han 100 1A, e enor associled wilt Fis b & nagigile in mod apicaons

Figure 1. Simplified Application

*Far additanal information an our Pb-Fres strategy and soldering details, please
download the ON Semiconductor Sokdering and Maunting Techniques Refensnos

Manual, SOLDERRMWDO.

Figra 1- O datasheet na forma original
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resistor between the adjustment and
output, the LM350 can be used as a
precision current regulator.”

A figura 1 mostra o datasheet na
forma original.

(*) Observe que na literatura téc-
nica inglesa nao é usado o termo
“tensdao” como nds fazemos, mas sim
“voltagem”. Na tradugé&o devemos
tomar cuidado para traduzir sempre
“voltage” por “tensao”.

(**) Shutdown e um outro termo
técnico que na maioria dos documen-
tos que encontramos é mantido na
forma original.

Inglés Instrumental

A tradugao do texto:

“LM350

3,0 A, Saida Ajustavel, Regulador
de Tenséao Positiva

O LM350 consiste em um regulador
de tensdo positiva ajustavel de trés
terminais, capaz de fornecer até 3,0
sobre uma faixa de tensdes de saida de
1,2V a 33 V. Esse regulador de tenséo é
excepcionalmente facil de usar e requer
apenas dois resistores externos para
fixar a tensdo de saida. Além disso,
ele emprega um limitador interno de
corrente, shutdown térmico e compen-
sagdo para area segura, tornando-o
essecialmente & prova de queima.

O LM350 serve para uma ampla
variedade de aplicacdes, incluindo
regulagem local ou na placa. Esse
dispositivo também faz um regulador
comutado ajustavel simples, um regu-
lador de saida programada, ou pela
conexao de um resistor fixo entre o
ajuste e saida, ele pode ser usado
como um regulador de corrente de
precisdo.’ T

- Prqcessadores *Dlod:os
» Transistores
* CICMOS =Cl Limms +CITTL
» Vélvulas vResiamés, Capacitores
* Transformadores, Indutores, LEDs
»Componemes Antigos

: Dmonhnuados

Vendas pela internet de aparelhos
e componentes eletronicos para
desenvolvimento de projetos
e reparacdo. Receba onde vocé
estiver, através dos correios.

Av. Celso Garcia, 4219 - Tatuapé
Sao Paulo - SP

CEP 03063 - 000

Tel: (11) 2294 5824

Fax: (11) 6197 7499

e-mail: eletronic@reidosom.com.br




Solucoes

Coletéanea de circuitos
alimentados por 1,5V

Diversos sao os circuitos eletronicos que podem ser
alimentados por apenas uma pilha simples de 1,5 V
e alguns deles podem ser muito interessantes pelo
seu funcionamento, aplicacao ou apenas para
entretenimento e aprendizado de circuitos
usados na eletronica. Apresentaremos alguns
circuitos muito simples de montar e de
funcionamento imediato, sendo uns mais
faceis e outros mais dificeis de ajustar,
mas nada impossivel.
0 interessante de alimentar os
circuitos com apenas uma pilha

consiste no fato de que eventuais enga-
nos nas montagens, troca de transistor,

Paulo Bergo

forma, modificagoes
podem ser feitas a
vontade, logicamente,
com certo limite.

inversao de polaridade,
etc. reduzem o perigo
e as chances de danificar
os componentes. Dessa

1 - Transmissor de FM

Nosso primeiro circuito € um pe-  riente. A bobina consiste em seis voltas
queno transmissor de FM, capaz  de fio comum, de ligacdo, possuindo 1,5V L =4 voltas
de levar os seus sinais a pequenas  uma tomada ou derivagdo na terceira de fio 18 a
distancias (de no méaximo uns 50 m),  espira, ou seja, bem no centro. A = C hﬁﬁeec”;m
dependendo do alcance do receptor. mesma pode ser enrolada em torno de v S
Os componentes sao todos comuns, um lapis comum e possui nucleo de ar. Ant
ndo trazendo qualquer tipo de pro- A figura 1 mostra o circuito do nosso C =10 pF ou
blema para o montador menos expe-  pequeno transmissor, cuja montagem timmer
final fica extremamente pequena. M ﬂ
i 10 pF
L = 6 voltas de fio eletreto I?F 494 §
c  18a26com 2 - Outro transmissor de FM 100 i
tomada central, .
nticleo de b : :
Ant] arforma de l4pis Nosso circuito seguinte consiste em : i
um outro transmissor de FM (figura Figura 2 - Outro transmissor de FM
M 2), tendo um alcance um pouco maior.
Aqui, os componentes sdo corriquei- 0 comprimento da antena pode ficar
i BF 494 ros, devendo-se observar apenas a  entre 1 e 20 cm e o fio usado pode ser
eletreto C=10pFou ligacéo do transistor e do microfone  qualquer, desde que se auto-sustente.
de eletreto. A bobina é formada por  Podem ser utilizadas pilhas-botao, o

guatro voltas de fio comum em nucleo
de ferrite. Como no circuito anterior,

que confere a montagem um tamanho
final bastante reduzido.
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O terceiro cir-

cuito é um receptor

para a faixa de ondas

médias. Novamente, os

componentes sdo todos

comuns, a bobina compoe-se

de 100 voltas de fio bem fino,

enroladas sobre um bastao de

ferrite de cerca de 10 a 30 cm, tendo

uma tomada na sua décima espira.

Observe atentamente as ligagbes

do capacitor variavel e da bobina no
circuito.

Testes podem ser feitos, deslo-
cando-se a tomada de derivagéo
para cima, no sentido de melhorar
a sensibilidade, porém isso piora a
seletividade, mas podera ser feito
conforme a necessidade do leitor.
Caso necessario, é possivel adicionar

3 - Receptor para a faixa de ondas médias

L = 100 voltas em PY

ferrite de 15 a 30
cm. Deriv. na décima
espira a partir do terra.

IN45 100 nF

cv 10 voltas

uma antena, por meio de um capacitor
de cerca de 10 a 100 pF na centésima
espira da bobina, ou seja, no lado
oposto ao do terra.

Nesse circuito (figura 3), o fio terra
nao é necessdrio, mas em certos

e e

Figura 3 — Receptor para a faixa de ondas médias

1,8V

1 MQ
BC 558

Fones

casos, melhora a recepgao. Pode
ser usado um fone de ouvido ou até
mesmo, um falante pequeno, conforme
o caso. O diodo de germanio admite
diversos equivalentes.

e

4 - Transceptor para a faixa de radioamadores

Como quarto circuito, temos um
transceptor para a faixa de radioama-
dores, que opera na banda de 40 m
(7 MHz), dependendo do cristal usado
(figura 4). Os componentes néo séo
criticos, porém, os do circuito tanque
(os ligados ao coletor do BD139) séao
os Unicos de valores criticos, pois
irdo suprimir as harménicas durante a
transmissao. O fone é do tipo comum,
assim como 0os demais componentes,
dispensando maiores comentarios.

O oscilador é do tipo colpitts, con-
trolado a cristal. Outras frequéncias
podem ser experimentadas, desde
que sejam trocados o cristal e os
componentes do circuito tanque. Por
exemplo, para a faixa de 80 m (3,58
MHz), no lugar dos capacitores de 470
pF sdo colocados valores dé 820 pF
e o indutor de 1,5 pH, é substituido
por um de 2,2 pH. O trimpot ligado a
base do BD139 serve para controlar
sua polarizagdo, aumentando o sinal
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na saida, que devera ter uma carga
adequada (antena, ou maximo brilho
na lampada para ajustes) de 50 ohms.
O fone e o manipulador podem ser
ligados por meio de jacks. A poténcia
conseguida com esse circuito gira em
torno de 20 mW, mesmo alimentado
com uma simples pilha.

Soltando o manipulador, o circuito
fica habilitado para receber sinais e,
quando o manipulador é pressionado,
o circuito passa a transmitir os sinais.
Tal disposi¢éo de circuito € pouco
conhecida pela maioria dos leitores
e foi baseada em um famoso circuito
da Internet, o chamado “PIXIE2 trans-
ceiver”. Existe uma infinidade de sites
mostrando esse fabuloso circuito,
extremamente enxugado e que fun-
ciona muito bem.

Evidentemente, é necessario usar
uma antena adequada, dessas utiliza-
das pelos radioamadores. O tnico
componente mais dificil de achar
no comércio é justamente o cristal,
havendo algumas possibilidades:
mandar cortar o cristal para a frequén-
cia desejada ou adquirir um ja pronto
no comércio (7,121222 MHz).




(D

5 - Transceptor para a faixa de 144MHz

Este transceptor também é de
baixa poténcia, sé que dessa vez, o
mesmo é capaz de gerar sinais na
faixa de 144 MHz. No caso dessa
freqliéncia, os cristais devem ser sub-
multiplos da mesma. Por exemplo:
usando um cristal de 24 MHz, a sexta
harménica ira cair em 144 MHz e,
assim por diante. O que se faz é
sempre sintonizar o circuito tanque
(bobina e capacitor) nessa frequéncia.
O principio de funcionamento é seme-
Ihante ao do circuito anterior e permite
uma ampla gama de experimentos,
sem risco de queimar nem danificar
os componentes. Contatos podem
ser tentados com outras estagbes de
radioamador. Observe a figura 5.

10 k2

XTAL 100 pF
24,48, R I

72 ou
144 MH z -'

Figura 5 — Transceptor para a faixa de 144MHz

01,8V
L = 4 voltas em
nicleo de ferrite

C=4,7 pF

Nota: L e C devem
ressonar em 144 Mhz

)BC 558

Fone

Finalmente, nosso ultimo circuito
(figura 6) consiste em um eletroscopio,
ou seja, um detector rudimentar de
cargas elétricas, dessas que se obtém
ao friccionar um pente ou régua de
plastico contra roupas ou cabelo. O
aparelho detectara as cargas pela
variagdo do tom emitido por um osci-
lador de baixa frequiéncia. Caso o leitor
queira, podera alimentar o circuito com
3 V e, no lugar do oscilador, colocar
um LED. O oscilador, assim como
o LED, funciona como carga para o
terceiro transistor BC548 colocado
em cascata.

6 - Eletroscopio

Ant.

1 m fio
100 k2
alMQ

BC 548

100 nF a1 pF

BC 548

Figura 6 - Eletroscopio

Os circuitos mostrados aqui tém o
objetivo de levar aos leitores menos
experientes, algumas montagens
simples, usando uma unica pilha e,

que proporcionam resultados satisfa-
térios. O baixo risco de danificar os
componentes mediante eventuais
enganos, a simplicidade, o baixo custo

dos componentes e 6 aprendizado na
montagem séo as principais caracte-
risticas dos circuitos apresentados.

r
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uvindo atraves
das paredes

E claro que niao propomos nenhum truque

misterioso que transponha um sensor, pas-
sando para o outro lado de uma parede
para captar conversas e outros sons. O que
apresentamos é um sensivel microfone, tipo
estetoscopio, que tanto pode servir para
ouvir o que se passa do outro lado, como
dentro de uma parede detectando sons de
vazamentos de agua, por exemplo. Se o
leitor deseja um aparelho como este, eis a
oportunidade de monta-lo com componentes
comuns de facil obtencao.

m aparelho cobicado por deteti-

ves e espides é o microfone que
permite ouvir “através das paredes”.
Obviamente tal aparelho esta ainda no
campo da ficgdo, se bem que existem
algumas alternativas interessantes
que comegam a ser pesquisadas ou
que empregam tecnologias muito
avancgadas, portanto fora do alcance
do montador comum.

O que propomos é um microfone
ultra-sensivel que detecta sons muito
fracos, os quais podem passar atraves
de uma parede fina e captados se

Microfone
Amplificador

|

«——Parede

Figura 1 - Estrutura do projeto
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Montagem

'/

Newton C. Braga

Figura 2 - Uso de microfones para deteccéo de vazamentos )

usarmos uma configuragao sensora
apropriada.

O que temos entao é um amplifica-
dor de ganho ultra-elevado, com um
microfone comum colocado em um
sistema de almofada concentradora de
sons, conforme mostra a figura 1.

Microfones deste tipo tém sido
usados por empresas de fornecimento
de agua para detectar vazamentos
ocultos (pelo som que produzem), veja
a figura 2.

Empresas de fornecimento de agua
enviam entdo seus técnicos com tal
aparelho, normalmente a noite quando
o ruido ambiente & menor, para tentar

descobrir aqueles vazamentos impos-
siveis que fazem com que uma conta
de agua atinja valores absurdos sem
que haja sinal evidente do que esta
acontecendo...

Veja, portanto, que nosso aparelho
nao tem apenas uma finalidade recre-
ativa dado que ele pode ser usado
para:

e Detectar vazamentos;

e Detectar ruidos estranhos que
ocorram devido a animais ou insetos
alojados em construgdes (paredes,
forros, etc.);

o Detectar ruidos provocados pelo
funcionamento anormal de maquinas.

35
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; Montagem
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» Detectar estalos e mudangas de
posigédo de vigas e paredes, quando
submetidas a esforgos no sentido de
verificar se tém alguma trinca ou outro
problema.

O circuito proposto é alimentado
por pilhas comuns e tem um consumo
relativamente baixo, o que o torna
totalmente portatil.

Como funciona

Um microfone de eletreto envia seu
sinal para uma etapa pré-amplificadora
de audio com um ganho muito alto.
Esta etapa é formada pelos transis-
tores Q4 e Q, cujo ganho é dado
basicamente pela relacao entre os
resistores de polarizacao de base e
coletor.

Esta etapa é do tipo com acopla-
mento RC para maior simplicidade
de projeto.

O sinal dela é levado a entrada de
um amplificador integrado de ganho
200, o qual é determinado pelo capa-
citor Cs. Veja que na passagem do
sinal de uma etapa para a outra temos
o potenciémetro de controle de sensi-
bilidade P;.

O sinal amplificado pelo circuito
integrado é levado a um fone de ouvido
onde é feita a sua reproducéo.

Para que o circuito tenha resultados
satisfatérios existem duas condigdes
importantes que devem ser satisfeitas
na montagem.

A primeira é a utilizacao de uma
almofada captadora onde o microfone
é instalado de modo a concentrar

Plugue estéreo

Figura 3 - Fone de ouvido

apenas 0 som que vem atraves da
parede. Detalhes construtivos desta
almofada sensora seréo dados mais
adiante.

A segunda consiste no uso de um
fone de ouvido acolchoado de baixa
impedancia. Este tipo de fone, ilustrado
na figura 3, tem duas finalidades
neste projeto. A primeira consiste
na concentragdo maior dos sons no
ouvido da pessoa que utiliza o apare-
Iho, obtendo assim maior rendimento.

A segunda consiste em evitar o
fenémeno da realimentacao ou micro-
fonia, indicado na figura 4.

Quando o microfone de um equi-
pamento de som capta o proprio som
que ele reproduz, o sinal circula rapi-

L )

Realimentagéo
,-"""‘.“__-_“"“\-*

damente pelo circuito produzindo um
apito intenso. E o apito que surge
quando abrimos volume de um equi-
pamento de som no qual esteja ligado
um microfone.

Com o uso de um fone acolchoado
evitamos esse problema, ja que a
sensibilidade do circuito é elevada.

A alimentacao do aparelho vem de
4 pilhas comuns e como 0 consumo
nao é dos mais altos, elas terao uma
boa durabilidade.

Montagem

Na figura 5 temos o diagrama
completo do aparelho para “ouvir
através das paredes”.

A placa de circuito impresso para
sua implementag@do e mostrada na
figura 6.

Para conexdo do microfone ao
aparelho deve ser usado um cabo
blindado. Na figura 7 fornecemos
detalhes para a montagem do sensor
e a conexao do cabo, observando-se
a polaridade do microfone.

Microfone

A

Amplificador

Figura 4 - Microfonia

| o | L _——
Bl
Rs Rg
1kQ 5600
Cy Cs — C8
470 nF 28| |, catopF 100 uF
Cly
6o LM386_~5
4
BC548 | Py 314 CGJ: == o
10kQ o 220 pF
z
R7
10Q
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Disco de madeira
grossa ou metal (10 a 14 cm)
2 3 3cm

Borracha ou espuma grossa

Figura 7 - Sensor

O cabo pode ter até uns 3 metros
de comprimento para facilitar sua
utilizagao.

Os capacitores eletroliticos devem
ter sua polaridade observada. Para
conex&o do fone deve ser usado um
borne de acordo com o seu plugue.

Como a maioria dos fones de
ouvido do tipo acolchoado de baixa
impedancia é estéreo, e o amplificador
que usamos tem caracteristica mono
é necessario fazer a ligagao dos dois
canais em paralelo, o que é conseguido
no proprio borne, conforme ilustra a
figura 8.
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Jq

Fone
oV

Figura 8 - Ligacao em paralelo

Sem essa ligagdo, apenas um
canal funciona.

O conjunto pode ser alojado em
uma caixa de plastico, uma idéia para
facilitar seu uso seria dota-la de uma
alga para que ela possa ser levada a
tiracolo, conforme mostra a figura 9.

Jaque
para o fone

Figura 9 - Sugestdo de caixa

Montagem

Prova e uso

Para provar o aparelho basta colo-
car as pilhas no suporte, encaixar o
plugue do fone e acionar Py. Abra o
controle de volume. O som ambiente
deve ser ouvido de forma muito ampli-
ficada.

Experimente o aparelho encos-
tando o sensor numa parede em que
existam pessoas falando do outro lado
ou algum tipo de barulho.

Para usar é s6 encostar o sensor
na parede, procurando a posigao que
dé melhor rendimento. Se ouvir um
forte apito devido a microfonia, reduza
o volume.

Lista de materiais

Semicondutores: :
Cly - LM386 — amplificador de
4udio integrado

Q4, Q; - BC548 ou equivalentes —
transistores NPN de uso geral

_Resistores: (1/8W, 5%)
R4, Rz — 4,7 kQ — amarelo, violeta,
vermelho
R, — 1,5 MQ — marrom, verde,
verde

R4 — 220 k&2 — vermelho, vermelho,
amarelo
Rs — 1 kQ - marrom, preto, verme-
lho
Rg — 560 £ — verde, azul, marrom
R; — 10 Q — marrom, preto, preto

Capacitores: (eletroliticos para
6V, ou mais)

C4, Cg — 100 pF — eletroliticos

C,, C3, Cs — 10 pF — eletroliticos
C4 — 470 nF — ceramico ou poliés-
ter i

Cg — 47 nF — ceramico ou poliéster
C; — 220 UF — eletrolitico

P; — 10 k Q — potenciémetro (pode
incluir S4)

Diversos:
MIC - Microfone de eletreto de dois
terminais
Sy — Interruptor simples
B, — 4 pilhas pequenas
Z - Fone de baixa impedancia — ver
texto (4 a 32 Q)
Placa de circuito impresso, borne
para fone (estéreo), suporte de
pilhas, caixa para montagem, botao
para o potenciémetro, fios, solda,
etc.




Modulacao Digital de Sinais - Parte 3

Modulador BFSK

Augusto Carlos Pavao*
Marcio Antonio Mathias*

Neste artigo é abordada a modulacao FSK (Frequency Shift
Keying), que associa os simbolos digitais a diferentes valores de
freqiiéncia. Apresentamos também a simulacao e implementacao
deste modulador, utilizando componentes de facil acesso a bancada
da maioria dos laboratorios eletronicos.

a figura 1 temos um exemplo de
N um sinal modulado FSK. Cada
simbolo digital corresponde a um valor
diferente de freqtiéncia. No caso binario
teremos somente duas fregiiéncias.
Este sinal € comumente chamado
BFSK (Binary Frequency Shift Keying).
Desta maneira, a portadora estara
sempre presente, ndo importando qual
simbolo é transmitido.

Para sistemas digitais nao bindrios,
um numero maior de freqiéncias é
adotado, ampliando a capacidade de
transmissdo do sistema. Como visto
no caso da modulagao ASK (artigo
“Modulador ASK" da Eletrénica Total
n2117), agrupando-se dois bits, existi-
rao 4 possibilidades (00, 01, 10, 11),
conforme ilustra a tabela 1.

Agora, Af representa um desvio
em relagédo a freqliéncia nominal da
portadora. Cada freqiiéncia transmitida
corresponde a dois bits, dobrando a
taxa de transmissao do sistema em
relacdo ao BFSK. Sistemas desse
tipo, que utilizam multiplos valores
de freqiiéncia, sdo chamados M-FSK.

Cédigo bindrio

Tabela | - M-FSK com 4 freqliéncias
(quaternario) -

|

|

1il

Figura 2 - Modulacéo 4-FSK

Sinal Modulado e Sinal Modulador

n_ﬂ"ﬂ_ﬂ_

Sinal Modulado e Sinal Modulador
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Para ser adaptado

A figura 2 mostra um possivel sinal
4-FSK e seu respectivo sinal modula-
dor.

Demodulacao de
um sinal FSK

A demodulagéo do sinal FSK pode
ser realizada de duas maneiras distintas:
através de correlagao (técnica néao
abordada neste artigo) ou de maneira
mais simples, através de filtragem. Nesse
caso sao construidos filtros sintonizados
em cada uma das freqliéncias.

Na saida de cada filtro é posicio-
nado um detector de envoltéria, para
verificar a presenca da portadora.
Cada detector de envoltéria estara
associado a um dos simbolos digitais
transmitidos. Um circuito de deciséo,
baseado no nivel de saida dos detec-
tores de envoltdria, identifica o simbolo
recebido. Na figura 3 é apresentado
um diagrama em blocos de um demo-
dulador 4-FSK.

MECATRON!
Roho Zero

Conhega um novo kit

Construcao de um
modulador BFSK

A construgdo do modulador FSK
serafeita de maneira analoga a empre-
gada no modulador ASK. O diagrama
em blocos do nosso modulador é visto
na figura 4. A descri¢éo funcional de
cada bloco pode ser encontrada no
artigo anterior desta série. Novamente
utilizaremos o programa “SIMETRIX”

Solucoes

para simular os resultados.

Sao agora utilizados trés geradores
de clock; um para o gerador de padréao
pseudo-randémico, cuja frequéncia
determinara a taxa de dados binarios,
o gerador identificado como A, que
define o valor de freqliéncia fy (asso-
ciada & transmissao do valor binario
“um”) e o gerador identificado como
B, que define o valor de freqliéncia
f, (associada & transmisséo do valor

Filtro

Sinal 4-FSK

Detector de o
envolidria
€ |— Simbolo
Detector de o £ detectado
g
G

Figura 3 - Demodulacéo 4-FSK

de montagem de
fabricagao nacional

Mecatrdnico
a distancia

em diversos projetos

Conta-gotas
microcontrolado

Para projetos onde
seja necessdrio
o controle de vazdao

Feito com materiais barc_ltos
e que voa de verdade!



Solugoes

binario “zero”). A portadora senoidal é
sintetizada em 16 amostras discretas,
armazenadas em memdria EPROM.
A frequéncia dos geradores A e B
deve ser 16 vezes maior que f; e fy,
respectivamente.

O gerador de padrao (dados) con-
trola qual dos geradores, A ou B, tem
que ser selecionado para o endereca-
mento da memdria. Um conversor
D/A traduzira os valores da tabela em
valores de tensao.

Contador

binério

!

mmmn:to:> D/A

O diagrama esquematico do modu=
lador BFSK pode ser conferido na
figura 5. Uma seqiéncia bindria
(DADOS) do. gerador de padrao
modula a portadora, como se vé na
figura 6. T

*Augusto Carlos Pavao e Mércio Antdnio Mathias sdo
professores do Instituto Maua de Tecnologia (IMT).

Lista de Materiais

owoos T LT LTI T
7
6
5
g i i !
B | [ WA
2 | - EAEAEI
ARILIRIR | FIREETE
s ISR R ERVAR B
70 74 76 78 80 82
Time/mSecs 2mSecs/div
Figura 6 - Sinal BFSK
Gerador U1q Uy
declock A [V
aFn} Ui2 HC32D ADDO  OUTo—{D0 _0)_
Us Counter_4 ADD1 OUT1}—{ D1 OUT] BFSK
U2 ADD2 OUT2[—]D2
b DO ——0{ADD3 OUT3[—D3
Gerador Us D1 —Oo-{ADD4  OUT4[—|D4
de clockB |V D2 ADD5 OUT5[—|D5
(12) | D3| ADD6 OUTe[—|D6
ADD7 OUT7}—{D7
DAC_8
DINO us
Gerador U1o - Ug - @ DIN{
de clock | I\ . [ Dados DIN2
( dados ) S Dt | P DIN3
D2|— DIN4
D3— DIN5
D41 Us $—o-{DIN6
D5 _ U7 DIN7
D6 vee
! T—wanE_EN

Figura 5 - Diagrama esquematico do modulador BFSK
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Instrumentacao

(<

Projetos eletréonicos usando o MultiSim 9 do

Electronics Workbench — Parte 6

~ Simulacao de
~circuitos logicos
digitais

No artigo anterior estudamos os osciloscépios
encontrados no MultiSim 9 verificando seus prin-
cipais recursos. Depois, aprendemos a utilizar o
osciloscépio basico de duplo traco na analise do
amplificador de ganho 10 que desenvolvemos nas
licoes precedentes. Yimos nesse osciloscopio tanto
a forma de onda do sinal de entrada quanto a do
sinal de saida. Este artigo ira tratar do projeto
e simulaciao de circuitos logicos digitais e da
verificacao do seu funcionamento no analisador
légico disponivel na barra de instrumentos.

projeto e simulagao de circuitos

digitais é extremamente simples
no MultiSim gragcas a sua enorme
biblioteca de componentes légicos
tanto de tecnologia CMOS quanto
TTL, assim como pela presencga de
um analisador l6gico na caixa de
instrumentos.

Como projetar um circuito Idgico
digital € o que veremos neste artigo
e, depois, havera verificago de seus
sinais utilizando o analisador logico.
O que vamos observar pode ser facil-
mente estendido para circuitos de
maior complexidade e, na instrumen-
tagdo, outros instrumentos além do
analisador podem ser empregados.

.
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O circuito basico

Para que o leitor entenda como
projetar um circuito Idgico digital,
vamos tomar uma configuragéo basica
bastante conhecida, facilitando assim
a compreensdo de seu principio de
funcionamento. Montaremos um cir-
cuito seqliencial utilizando o conhecido
circuito integrado 4017.

Esse circuito tem 10 saidas
seqlienciais, o que é suficiente para
testarmos a capacidade de analise do
analisador l6gico do MultiSim 9, pois
ele é capaz de analisar até 16 sinais
simultaneos.

Newton C. Braga

Os circuitos logicos digitais
do MultiSim 9

Conforme podemos ver pela figura
1, na area de trabalho do MultiSim
9 temos acesso tanto a uma grande
quantidade de circuitos integrados TTL
como CMOS.

Basta clicar no icone na area de
trabalho, correspondente a familia
l6gica, para que a relagédo de compo-
nentes disponiveis se abra e possamos
selecionar o tipo desejado.

E justamente a partir desse ponto
que desenvolveremos Nosso projeto,
baseado em tecnologia CMOS.




Figura 1 - Localizacao dos circuitos integrados

Primeira fase

Montando um oscilador

de clock

Comecamos por selecionar o cir-
cuito integrado que vamos usar como
oscilador, abrindo a relagéo de circuitos
integrados CMOS, observe a figura
2 em (B).

Em (A) temos a relagéo das diver-
sas familias de circuitos légicos CMOS
disponiveis. Veja que € importante em
um projeto manter a compatibilidade
e em caso de se interligar familias
deferentes, esteja atento para os
fan-out e fan-in além das tensbes de
alimentacéo.

Select 4 Component

N 407580 _5Y

- [ :
T B e
8 cvos v

- Ry

8 cmos_ise

B ranc_av

A

“T0TALS38 - CURSO EWH -
i

Figura 3 - Selecionando o 4093

O circuito tomado como exemplo
para esse caso é o 4017 (C) para
5V, cuja pinagem conforme aparecera
na area de trabalho é exibida em (D).
Em (F) temos informagdes adicionais.
Para coloca-lo na area de trabalho,
basta clicar em (E).

Para iniciar nosso projeto, o circuito
integrado selecionado € o 4093 que
é formado por quatro portas dispara-
doras NAND.

Conforme vemos na figura 3,
fazendo a escolha desse circuito
integrado em (A), apenas uma porta
é colocada na area de trabalho, de
acordo o indicado em (B) e em (C),

OTET_W

AOTSER_ 5V

ATPBP_BV
AOTIBT_SV
ATHRD_SY

NG B
ABIET 5

AN74ED_TY

AN 5
AN7IET 5
A75ED_BV
01756 5
ANTHET T

0“ ﬂm_w
AR

a01860_5¢
ANBBF_G
ANAT_S
ANEEO_S

Figura 2 - Selecionando o circuito integrado

ficando a opg¢do de colocarmos as
demais portas.

Para isso, efetuamos a escolha
de outra porta, e em (B) do quadro de
didlogo que aparece, escolhemos mais
uma delas. Nao é o nosso caso, pois
iremos montar um oscilader usando
uma porta NAND.

Segunda fase

Completando o oscilador

Para completar o oscilador, con-
forme abordado nas edigGes anterio-
res, colocamos na drea de trabalho um
resistor @ um capacitor cujos valores
serdo programados para 10 nF e
10 k€ respectivamente.

As conexodes desses componentes
de modo a formar o oscilador completo
sao exibidas na figura 4.

Esse oscilador gera um sinal retan-
gular de 5 V de amplitude que, se o
leitor desejar, podera ser visto ligando
0 osciloscépio na sua saida. Este
assunto ja foi abordado em edi¢des
anteriores. O oscilador pronto servira
de clock para um contador divisor
por 10 que sera montado em torno
do circuito integrado 4017, conforme
veremos a seguir.

Terceira fase

Colocando 0 4017

Nosso préximo passo consiste em
abrir a tabela de seleg¢ao dos circuitos
CMOS e, na mesma familia de 5 V,
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selecionar o 4017, o qual sera colocado na area
de trabalho ao lado do oscilador de clock ja
montado. A seguir fazemos suas conexoes iniciais
ao oscilador e as dos terminais que devem ser
aterrados, conforme mostra a figura 5.

Um fato importante que o leitor devera ter
observado, é que os terminais de alimentagao
(Vss e Vdd) sao omitidos. Ndo é preciso ligar
uma fonte de alimentagéo, porque o simulador
a assume.

Evidentemente, na montagem real final deve-se
prever a ligagdo dos pinos de alimentagéo positiva
‘e negativa em todos os circuitos integrados
usados.

Quarta fase

O analisador légico

O analisador légico consiste em um poderoso
instrumento para a andlise simultanea de até
16 sinais em circuitos digitais. Esse instrumento
encontra-se acessivel na barra do lado direito
da drea de trabalho, bastando clicar nele para
colocé-lo na area de trabalho, conforme mostra a
figura 6. Veja que posicionamos esse instrumento
de modo que suas 10 primeiras entradas ja figuem
alinhadas com as saidas do 4017, cujos sinais
vamos analisar. As conexoes do analisador logico
ao contador sdo apresentadas na figura 7.

Clicando sobre o painel desse instrumento,
teremos acesso aos seus diversos controles.
Para maior facilidade na observacao dos sinais,
usamos o controle “reverse” para obter uma
imagem em fundo branco. Na condigao normal,
temos a imagem em fundo preto. O painel
detalhado do analisador Idgico é exibido na
figura 8.

O que o analisador faz ¢ plotar os niveis logicos
dos pontos dos circuitos analisados, usando como
referéncia um clock que tanto pode ser interno
como externo. O primeiro passo para analisar o
funcionamento do contador divisor por 10 com o
4017 é fazer os ajustes do analisador

Quinta fase

Ajustando o analisador légico

Abrindo o painel do analisador (basta clicar
sobre o instrumento na area de trabalho) teremos
acesso aos diversos controles, que devem ser
ajustados para permitir a visualizagéo dos sinais.
Na figura 8 ja mostramos esse painel, com dois
pontos que devem ser ajustados. O primeiro,
indicado em (A), consiste em se selecionar
2 clocks/divisao para observagao do sinal. O
segundo é para abrir o segundo painel de ajustes,
clicando em set (B), como podemos visualizar
na figura 9.

ELETRONICA T07AL- N° 1 18 / 2006
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Nele, selecionamos o clock interno
(A) e também uma frequiéncia de clock
de 10 kHz em (B). Com isso, o circuito
estara pronto para a simulagéo. Basta
entéo clicar em “acept” (C) para fechar
essa caixa de ajustes.

Sexta fase

Simulacao

Para simular o circuito, basta manter
o painel do analisador légico maximi-
zado e clicar em |/O. Teremos assim as
formas de sinais obtidos na saida do
circuito, observe a figura 10.

Repare que a amostragem é feita
com dois ciclos de clock por diviséo
e que, por problemas de sincronismo

: I Oscilador de Clogk - ContadonDiwsor per 10 . -
S s B it

| Analisador Logics ot

€

Figura 8 - Painel do analisador légico

com o oscilador externo, temos em
alguns instantes uma duragao maior
para o pulso de algumas saidas do
4017.

Sétima fase

Indo além com uma

barra de LEDs

O circuito simulado consiste em
um sistema seqiiencial que facilmente
pode excitar 10 LEDs comuns. Pode-
mos simular esse circuito conforme
mostra a figura 11.

Basta retirar o analisador l6gico
e, no quadro de diodos, abrir a lista
que mostra essa categoria de compo-
nentes. Nessa lista (A) temos diodos

0000, W00 1.300m

virtuais (B) e também LEDs (C). Na
relagdo de LEDs que selecionamos,
escolhemos uma barra de 10 LEDs
verdes, indicada em (D). Esse compo-
nente tem o aspecto exibido em (E).

Observe que as setas dao a sua
polaridade, o que é importante na
hora de fazer sua conexao ao circuito
simulado. Se os LEDs forem invertidos,
o circuito nao funcionara!l

Assim, ao colocar o indicador de
LEDs na area de trabalho, deveremos
gira-lo no sentido anti-horario (anti
CLW) para que ele fique em posigao
de funcionamento, conforme ilustra a
figura 12.

Depois é s6 fazer as ligagdes e
colocar um resistor limitador de cor-

Tune () |
1600m  2000m
Fin fe——

Pl L

RO

. ADIIBE_SY

T e e ]

Figura 9 - Segundo painel de ajustes

Bis

Figura 10 - Sinais obtidos
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Complete sua colecao

Adquira as edigOes anteriores da revista
Mecatrdnica Facil através do site:
www.sabermarketing.com.br
elo telefone: (11) 6195-5330 .,
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Figura 12 - Posicionando a barra de LEDs

para que o leitor aprenda a usa-lo

rente que, na pratica, devera terde 330  dependera muito do que ird neces-

a 470 Q para alimentagdode 5a6V e  sitar em um dado projeto. Com os

1 kQ para alimentagao de 12 V. conhecimentos béasicos abordados,

Clicando em O/l, que inicia a simu-  ja é possivel dar inicio a um trabalho

lagéo, o leitor vera os LEDs acende-  eficiente de projetos, tanto no nivel
rem em seqiéncia, comprovando o  amador como profissional.

H
-
o
N -
T
u
w
=
A

funcionamento do circuito. Na préxima edigdo iremos além, demandires

mostrando mais alguns recursos e
L importantes do MultiSim 9. i ) y Wnlidar
Conclusao £ A
O que vimos neste artigo foi um Versao Demo ' 5‘

pouco do que o leitor podera fazer em Para acompanhar estes artigos, nada K3 B

termos de simulagéo e projeto usando melhor do que ter acesso a uma B ot

0 MultiSim 9. Existem ainda muitos versao demo do Electronics Work- - BN -

outros recursos e componentes para bench. Essa versdlo, que faz tudo ) § .

: e que precisamos para aprender a
o leitor utilizar e testar em novas con- usar o EWB, esta disponivel no site

figuragdes. A exploragédo do programa www.ni.com/brasil
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RELATO:

Iniciei a pesquisa testando os transistores de saida
de video, mas tudo estava normal até a excitagao 50
dos catodos do TRC. Segui a linha de 180 V, onde |

notei o capacitor 457 aparentemente inchado. D416
Retirei o componente do circuito, constatando que
estava completamente sem capacitancia e com

R
residuos em seus terminais. Fiz a substituicdo ] ?34;22 —-I l— é‘;o“\';] I\

desse componente e, com isso, o televisor voltou a C451

funcionar normalmente.

—» A placa
do cinescopio

Rgop

180V §5295G 180 V

Cas7 é

: -@OQ@-

Capacitor

680 (500 V) com defeito (seco)

A
RELATO: R
! ol e A 601
Antes de alimentar o circuito, realizei (SKE2104) 8.2 Q/3W j S
uma revisdo nos componentes da fonte Linha 10,5 V o
primaria onde aparentemente estava g Budio
tudo em ordem. Depois, apliquei tens&o ICs01
de 220 VCA na entrada da fonte cons- ' 123 LA 4268 19
tatando apenas um zumbido devido ao ; Jj s AR NN
excesso de consumo. A tenséo de +B de i Em curto
183 V para alimentar a saida horizonal P MG ] =7 (pino 3 para 1)
era nula. T800
Com a ajuda do esquema, fui ao transis-
tor de saida horizontal ndo encontrando continuidade para o chassi atraves a alimentacdo dos 10,5 V através do
nenhum problema. Desliguei um dos do segmento da linha de 10,5 V que resistor R-601 de 8,2 ohms x 3 W. Com
terminais dos diodos que fazem parte alimenta o pino 3 do IC-601 da saida de o pino 3 do IC-601 desligado, alimentei
do grupo 800 (fonte) e do grupo 400 audio (LA-4265). Fui desligando todos os novamente o circuito da fonte primaria e
(horizontal), mas estavam todos bons. capacitores desta linha e a fuga para o o televisor teve o funcionamento normal
Percebi, entretanto, que o D-720 quando chassi continuava mesmo assim. da fonte com a imagem na tela do TRC.
no circuito apresentava uma resisténcia Finalmente, cheguei ao pino 3 do IC-601 Depois, desliguei o televisor e realizei
de 8,6 ohms em ambos os sentidos. que se encontrava com uma resisténcia a substituicdo do 1C-601. Religuei o
Como o diodo estava bom fora do cir- muito baixa em ambos os sentidos entre televisor e com isso o sinal de audio
cuito, segui realizando medidas de o pino 1 e o pino 3. O pino 3 recebe voltou ao normal.
'
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RELATO:
Analisei os pinos do fly-back para ver se

v,
nao havia solda fria. Medi a tensao de W
24,5V no pino 11 do fly-back e no pino Traco
9 do IC301. Nesse ultimo ndo encontrei horizontal

tensdo. Analisei o diodo D404, medindo
sua continuidade. Estava bom e pela
linha de alimentagéo fui ao resistor

Praticas de Service

—R420 10

!D 404

D301

R420 de 1 ohm, encontrando-o aberto. D ? 2;’5 V? ? 24V
Troguei esse resistor e, com isso, a wr | R ov
tensao se restabeleceu e o televisor 5
voltou a funcionar normalmente. IC 301 (AN 5512)

Estagio defeituoso

s

24V

C 457 \

470 uF Resistor
o5y  aberto

i3

Saida vertical

(T 444 )

RELATO: Wl :
Ao ligar o televisor, verifiquei que o el R 10 gﬂi?,}f:;ﬁ 1%1{,
som era normal, mas a tela permanecia 10kQ 4 3
escura. Inicialmente achei que nio Lso2 ] £
tinha alta tensdo, mas ao fazer os 125pH  Csos L 3 2
testes encontrei-a correta. Passei L%OOrLFT J- by
entdo a verificar os 12 V da fonte, :
encontrando essa tensd@o normal. No
entanto, observei que o filamento do Rs11 Dsp1
cinescopio ndo acendia e ao testa-lo Rs09 180 kQ E008
constatei que estava aberto, ou seja, 56 k() ‘ 9
queimado, Foi necessario entao trocar
o cinescoépio. 133?3;?‘- sl

Cinescopio

10 kQ

RELATO:

caso teriamos o aquecimento do componente. Continuando
a pesquisa em busca da causa da avaria, apés muitos testes
com componentes da fonte, cheguei a C708 (300 pF x 300 V),

.

Capacitor Ao pino 4 chave

Comecei a anélise medindo as tensées na fonte de alimentagao com defeito  geletora de tensdo
nos pontos U3 (12 V) e U1 (188 V), onde segundo o multimetro Ao pino 1 ‘ cs
estavam com 9V em U3 e 120V em U1, bem abaixo do normal. ~ chave seletora
O ponto comum das duas fontes era o transformador T701. A hen ZODUOL;,F D 714 A i
Verificando as tensdes no secundario desse componente, A~ ___',Qc703
encontrei-as com valores reduzidos. Cheguei a pensar que L 701 R = C712
poderia estar havendo um curto entre espiras, mas nesse 7 750 ,F

100 kQ 250V

capacitor a 6leo, com vazamento. Com a troca desse capacitor,
o aparelho voltou a funcionar normalmente.
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Praticas de Service

RELATO:

Analisei o circuito de saida vertical.
Medi tensdes nos pinos do IC501/
LA7830, onde encontrei 3 V num pino
que deveria ter 24 8 V.

Pela linha de alimentagéao cheguei ao
diodo D711, o qual é ligado ao resistor
R741 de 1 ohm x 1/3 W e ao pino 11

do fly-back. No catodo desse diodo
éncontrei uma solda fria. Ressoldei e,
com isso, o televisor voltou a funcionar
normalmente.

RELATO:

C 721

R 313

O cliente disse que havia levado o
aparelho em outra oficina, onde nao
conseguiram descobrir o problema.
Comecei por medir capacitores do
circuito vertical. Apos varias medidas

C 711 D707 encontrei o capacitor C47 de 100/35
560 pF Ao pino com 96 pF. Feita a troca, o aparelho
IC q :
o ah o0 2KV 3 do IC 301 voltou a funcionar normalmente. Notei
C73a 15V LA 4265 que a dificuldade do outro técnico foi
:l 0.001 llF gue, com apenas 4 pF de diferenga, ele
T ' a . .
T T3 % 5 16 7 i 3zh:oumql.:;::tc; seria isso o problema
X3V L . :
ATensio correta 24.80A 3 3
+Tens&o incorreta : G5 (5)
Estagiocom Sonsec) O
defeito fonte D711 s 0
® Clapr |2
@ : defeito
R 741 Ao pino Com
Solda fria 736 i 3 “% ’ Spdo RN $
0,001 pF
' 1/3W ~ IC 701 —LH—l——U Ii
@ g D 404 Cap7
. A\

RELATO:

Ao ligar o televisor, embora a lampada
indicadora liga/desliga NE8O1 estivesse
funcionando, o aparelho nao tinha nem som
nem imagem. Ao analisar as tensdes da
fonte de alimentagao, verifiquei que estavam
muito baixas e o trimpot R817 (470 kQ)
nao ajustava o +B de 112 V. Ao examinar
os resistores R814 (18 kQ x 1,6 W), R815
(18 k&2 x 1,6 W) e R804 (8,2 k2 x 1,6 W)
encontrei-as abertos. Feita a substituicdo
de todos os resistores, o aparelho voltou a
funcionar normalmente.

Resistor abeno
L
Rresistor TRg03 9814
aberto 10 nk BC337—16 18 kO
n\ Dgos ] i 1,6 W
. 280k?1 [} 151886-FA iy
¢ 809 Rg1
1.6 W Cgo7 10 kQ2 Bskfl
e —H e
[ Ra11
i p Rgos | |24 k2
806 a
47 uF Rg12 [ 1Rs16
160 V 24k | |2 kQ
Rgos R
817
300 ka2 470 kQ
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é 3 Microcontroladores

ICD 2

Parte Fin

ara melhor compreenséo deste
P artigo, vamos elaborar passo
a passo um pequeno projeto, com o
intuito de explorar as caracteristicas
do MPLAB IDE em conjunto com o
depurador /CD2BR. O projeto envolvera
desde a digitagdo do cédigo-fonte até a
gravacao do cédigo no PIC, fazendo-o
funcionar de forma auténoma.
O nosso projeto sera o famoso
“Pisca-LED”, cujo circuito € mostrado
na figura 1. Escolhemos o modelo
PIC16F877 ou PIC16F877A, por ser
um dos mais faceis de encontrar com
suporte a ICD.
Alguns leitores podem imaginar
o porque de nao utilizar um modelo
menor, como o PIC12F629 ou até
mesmo o PIC16F628A para uma tarefa
tao simples. A razao, ja vista na pri-
meira parte deste artigo, € que para
usar estes modelos necessitariamos
de um PIC “especial”, o qual nao é

50

Na primeira parte vimos como instalar e
configurar o ICD 2 (ou o ICD2BR), agora iremos
acompanhar todos os passos necessarios para
iniciar um pequeno projeto no MPLAB IDE e
utiliza-lo junto com o ICD 2.

muito facil de ser encontrado aqui no
Brasil. :

No quadro 1 temos o codigo-fonte,
em Assembly, porém poderia ser
empregada qualquer outra linguagem
compativel com o MPLAB IDE.

Este projeto foi montado em uma
matriz de contatos, e para sua cone-
xd@o com o ICD2BR confeccionamos
um cabo tipo ICSP (In Circuit Serial

Richard A. Weigel

Programming) conforme a figura 2,
saindo do conector RJ12 (ICSP LabTo-
ols) para a matriz de contatos.

Na tabela 1 vemos a pinagem dos
sinais utilizados, lembrando que a
alimentagéo do circuito sera fornecida
pelo ICD2BR, por isto devemos ter
certeza que o item “Power Target Circuit
from the MPLAB ICD 2’ esteja assina-
lado, conforme ilustra a figura 3.

Xti1
EOV ' 5‘:‘}‘ 4 MHz
Conector R4 |-—|m—|
ICSP ok 20‘ 9 10
Dados 2817 Cly
Clock 2nB6 piciGre7  RAC
Vdd (5V)
o S
NZo utilizado J_ .

Figura 1 - Circuito utilizado como exemplo
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e e o a8

Figura 2 - Cabo ICSP usado nos testes

MPLAR ICD 2 Settings

[ St | Commurcasion | Lovaatona | Power [Program [ Varsers | Wamega|
496 |

L

1378

Tasget Vid
Tanget Vpp
MPLAB ICD 2Vpo
Vialues ave updabed on conmechion, requasts o
update, and powet seiting changes:

|

[] Paoweer target circul from MPLAB ICD 2 (5V Vid) |
1

i

Pino do RJ 12 Sinal Pino do ICSP
1 ( Azul) Néo utilizado 1 (Azul)

2 ( Amarelo ) GND 2 ( Amarelo )
3 ( Verde ) Vdd (5V.) 3 ( Verde )
4 ( Vermelho ) SCK { Clock ) 4 ( Vermelho )
5 ( Preto ) SDA ( Dados ) 5 ( Preto )

6 ( Branco ) Vpp(13V.) 6 ( Branco)

Alguns comentarios sobre o
codigo-fonte

Antes de iniciarmos, vale ressaltar
alguns aspectos do cddigo-fonte de

Tabela 1 - Pinagem dos sinais utilizados no ICSP

nosso projeto que, apesar de simples,
tem alguns detalhes que merecem
destaque.

O primeiro deles refere-se aos itens
necesséarios para que o depurador

Quadro 1 - Listagem do programa e em destaque (vermelho) as instrucées necessarias para

a depuragao

LIST p=16£877

; Definigdo do PIC

#INCLUDE <pl6£877.inc> ; Variaveis das definigdes do PIC

__CONFIG _CP_OFF & DEBUG ON & WDT_OFF & _BODEN_OFF & _PWRTE ON

& HS OSC & _LVP_OFF & _CPD_OFF
VARIAVEL_DO_TEMPORIZADOR SET 0x20
RESET

ORG 0x000

nop
CONFIGURAC. O

banksel TRISA

bef IRISA,OD

movlw b’00000111’

movwf ADCON1

banksel PORTA
INICIO

bsf PORTA,Q

call TEMPORIZADOR

bef PORTA,O

call TEMPORIZADOR

goto INICIO
TEMPORIZADOR

; Area de Reset do PIC
; Requerido para o ICD

;Muda para o BANK 1

;Configura apenas o PORTA 0
como saida

;Configura as portas A/D

;Volta para o BANK 0
;Acende o LED

;Tempo com o LED Acesso
;Apaga o LED

;Tempo com o LED apagado

;Rotinas para o temporizador

movwf VARIAVEL DO TEMPORIZADOR

TEMPORIZADOR 0

decfsz VARIAVEL DO_TEMPORIZADOR,F

goto TEMPORIZADOR 1

return

TEMPORIZADOR 1
addlw .1
btfss STATUS,Z
goto TEMPORIZADOR_1
goto TEMPORIZADOR 0
END

; Fim do programa

Figura 3 - Verificando se o item “Power
Target Circuit from the MPLAB ICD
2’esta assinalado

funcione. No caso do PIC16F877
ou PIC16F877A, temos que utilizar
os parametros “_ DEBUG_ON” para
habilitar o modo de depuragéo e
“ WDT_OFF” para desabilitar o WDT
(Watch Dog Timer).

E importante que a primeira instru-
¢édo (nao confundir instrugdo com
diretiva) seja obrigatoriamente um
“NOP”.

Outro item importante refere-se os
pardmetros de configuragéo do PIC.
Em nossos primeiros testes nao
configuramos de forma adequada
as entradas de /O e A/D do
PORTA. Apesar do circuito funcio-
nar, ou seja, o LED piscar, no
depurador as coisas ndo saiam
como o esperado.

Por esta razé@o recomendamos
sempre que sejam verificadas as
configuragdes do PIC, consultando
freqientemente as recomenda-
¢bes do fabricante no data sheet
do modelo escolhido.

Iniciando um
novo projeto

O conceito de projeto adotado
pelo MPLAB IDE visa agrupar
arquivos e configuragdes relacio-
nados a um determinado projeto
em um unico local. Dessa forma
podemos trabalhar em outros pro-
jetos, com caracteristicas bem dife-
rentes e sempre que for necessa-
rio voltar a este projeto, o MPLAB
IDE iré lembrar de todas as confi-
guragoes.

Com o MPLAB IDE aberto,
vamos dar inicio ao nosso projeto.
Inicialmente clique em Project
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E 3 Microcontroladores

> Project Wizard... para iniciar o assis-
tente de projeto, como exibe a seqiiéncia
da figura 4. Na janela nomeada “Step
One” (Passo Um) devemos selecionar
o “Device” que sera utilizado no projeto
que, no Nosso caso, serd o PIC16F877.
Na janela “Step Two" (Passo Dois)
inicialmente nao sera necessario alterar
nada. Aqui seriam definidas as ferra-
mentas de trabalho empregadas no
projeto.

Na janela “Step Three” (Passo trés)
é onde definimos o nome e local dos
arquivos de nosso projeto.

Caso o leitor j& tenha o cédigo-fonte
(programa) digitado em um arquivo,
poderia acrescenta-lo no “Step Four’
(Passo Quatro). No nosso exemplo
iremos criar este arquivo mais adiante.

Criando o codigo-fonte

O préximo passo, como mostra a
figura 5, iremos criar o caddigo-fonte
(programa) de nosso projeto. Primeira-
mente cliqgue em File > Add New File
to Project... , digite 0 nome do arquivo,
com a extensdo “ASM” e na préxima
janela digite o programa, mostrado no
quadro 1.

Compilacao
do programa

Apos a digitagdo do programa, ainda
em uma linguagem que nds entende-
mos (ou quase todos entendem), sera

necessario fazer uma conver-
sao para uma linguagem que o
PIC entenda. Este processo &
comumente chamado de com-
pilacéao.

Clique em Project > Build All
e aguarde o processo de com-
pilagdo, como mostra a figura
6, atentando as mensagens
de alertas e erros que podem
ser lidas na janela “Output’.
E importante que nao haja
nenhum erro.

Ativando o Debugger
(ICD 2)

O préximo passo é ativar o
Debugger conforme a figura
7. Se forem detectados proble-
mas, vale a pena rever 0s pos-
siveis erros vistos na primeira
parte deste artigo.

Figura 4 - Assistente para criagao de um novo
projeto

Figura 6 - Compilagéo do programa
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Literatura Técnica

Que nao pode faltar em sua biblioteca

TELEFONIA

R$ 18,90

R$ 22,90

Curso Basico de Telefonia

Autor: Pedro Medoe

Reunimos nesta obra, alguns assuntos basicos
sobre telefonia em geral, além de casos e

algumas praticas que podem ser desenvolvidas.

Mecatroénica Industrial

Autor: Alexandre Capelli

Reunimos nesta obra os principais assuntos
relacionados ao “chao-de-fabrica” - de energia
a robotica - passando por redes de comunica-
¢ao, CLP's, CNC's, e outros mais.

Instalacoes Elétricas sem Mistérios
Autor: Newton C. Braga
Destacamos os seguintes itens importantes
neste livro:

* A importancia da ligacao a terra

+ A qualidade na energia

* Reparacoes em instalacoes

+ Seguranca

* |Instalacdo e reparacao de eletrodomeésticos
* Instalagdes industriais

Eletronica para Eletricistas

Autor: Newton C. Braga

Esta obra aborda de maneira objetiva os
principios basicos da eletrénica aplicada nos
dispositivos encontrados nas instalagoes elé-
tricas e analisa a maioria deles, explicando o
que sao, como funcionam e como sao encon-
trados exatamente nas instalacées ou nos
aparelhos que fazem parte das mesmas.

Curso Basico de Eletrénica — 5 Edicao

Autor: Newton C. Braga
necessidades de se conhecer mais sobre infor-

cacao da eletrénica no PC. No entanto, os
fundamentos abordados neste curso sao da
eletrénica na sua totalidade. Trata-se, por-
tanto da eletrénica que também é encontrada
em qualguer aparelho de uso doméstico, com-
ercial ou mesmo militar.

Montagem, Configuracao e Manutencao de
Computadores - Vol. |
Autores: Alexandre Capelli, Daniel Santoro, Fer-
nando R. da Silva, Luiz Fernando Aizawa,
Marcus B. de Moura, Newton C. Braga, Paulo
Couto, Pedro Henrigue G. da Silva
No primeiro volume o leitor encontrara entre
outros, os seguintes temas:

» Super guia para solucionar problemas;

« Como configurar o CMOS Setup dos BIOS de
placas-mae novas e antigas;

+ Como instalar placas periféricas (video, som,
rede, etc.) e evitar travamentos, instabilidades
e incompatibilidades do sistema.

0 enfoque principal dado neste curso, dadas as

matica e o computador em nossos dias é a apli-

R$ 22,90

www.sabermarketing.com.br

Curso de Eletronica Digital

Autor: Newton C. Braga

0 leitor encontrara neste curso os fundamentos aplicados a
informatica, automacao industrial, instrumentacao, telecomu-
nicacoes e mecatronica. Discorremos sobre uma eletrénica
digital aplicada a todos os equipamentos que a utilizem uma
forma que todos possam entender sem muitas dificuldades.

Cabeamento de Redes na Pratica

Autor: Pedro A. Medoe

No livro o autor descreve sua vivéncia no ramo das telecomu-
nicacoes, documentando casos reais das instalacoes de redes
locais, cabeamento residencial e automacao, PABXs digitais
com link E1 e componentes para sala E.P.D.

Curso de Instrumentacao Eletrénica Muitimetros —

Volume 2

Autor: Newton C. Braga

Neste segundo e ultimo volume, o curso trata das aplicaces
em eletricidade, automoveis entre outros e principalmente da
utilizacao dos multimetros True RMS. O bom funcionamento de
equipamentos eletrénicos de uma maneira geral e em especial
os das indastrias, dependem da qualidade da energia elétrica. O
multimetro comum nao atende as necessidades do técnico ou
engenheiro, sendo hecessario o uso dos multimetros True RMS.

Cuia de Consertos Eletroeletrénicos
Autor: Newton C. Braga e José Luiz de Mello
Esta obra é uma coletania de 200 reparos executados pelo
autor (José Luiz de Mello) e que serve como dicas para téc-
"% hicos de reparacao. Todos 0s reparos sao comentados pelo

B Newton C. Braga. Os aparelhos reparados sao os mais diversos,
" que vio desde televisores comuns até antenas parabélicas.

Reparo e Manutencéo de Monitores

* Autor: Autor: Newton C. Braga

Nesta obra, analisamos o principio de funcionamento dos
monitores de video, os modos como eles devem ser tratados,
0s defeitos comuns que eles apresentam e como devem ser
reparados.

Montagem, Configuracao e Manutencao de Computado-
res - volume Il
Autores: Daniel Santoro, Edgard Hideyuki Shine, Fernando R.
da Silva, Leonardo Andreozi, Luiz Fernando Aizawa, Marcos B.
de Moura, Newton C. Braga, Paulo Couto, Pedro Henrigue da
Silva, Ricardo Copriva, Roberto Luiz Cunha
Dando continuidade ao primeiro volume, neste segundo o
leitor encontrara entre outros, os seguintes temas:

= Como construir um laboratério para montagem e manu-
tencao e saiba o quanto cobrar por seu servico;

= Como monitorar e baixar a temperatura dos HDs,
aumentando usa vida util;

= Conheca e saiba como usar as placas e os softwares pro-
fissionais usados na manutenc¢ao de PC, gue resolvem pro-
blemas de dias em alguns minutos.

compre peto sie WWW.Sabermarketing.com.br outone (11) 6199-3330
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L

Figura 7 - Inicializando o ICD 2

Fazendo a gravacao em
modo de depuracao

A seguir, podemos fazer a gravagéo
do PIC. Este processo é similar a uma
gravagdo de PIC comum, porém sé&o
inseridos alguns controles extras
de forma que o programa sé rodara
se estiver conectado ao /ICD 2 (ou
ICD2BR). A figura 8 apresenta o pro-
cedimento para realizar a gravagao.

Depurando...

Agora, comega a parte divertida de
todo o processo!

Uma vez que o programa ja esteja
gravado no PIC, podemos finalmente
fazé-lo funcionar e para isto podemos
explorar cinco opgdes:

Run (F9)

A opcdo Run faz com que o pro-
grama “rode” como se estivesse fora
do ICD 2, ou seja, praticamente sem
nenhuma interferéncia do MPLAB IDE
ou ICD 2.

Selecionando, esta opgdo em
Debugger > Run ou simplesmente
pressionando a tecla F9, o LED do
circuito devera piscar.

Para interromper este ou qualquer
outro processo, cliqgue em Debugger
> Halt ou pressione a tecla F5 e caso
seja necessario reiniciar o programa,
utilize a agéo de Reset ou a tecla F6.

Animate
A opg¢ao Animate faz com que o
programa “rode” passo a passo. Com

isso 0 MPLAB IDE ira mostrar a linha
que o PIC esta executando.

Veja na figura 9 que o cursor (seta
em verde) indica a linha que o depu-
rador esta executando. Nesse exem-
plo esta em execugdo a linha “BSF
PORTA, (" que fara o LED acender.

Breakpoints (F2)

Um Brekpoint nada mais é que
uma parada programada no programa.
Observe que no modo Animate algu-
mas rotinas, como a do “TEMPORI-
ZADOR'’ em nosso programa, podem
levar muito tempo para serem conclui-
das.

Com o uso de um Breakpoint pode-
mos fazer com que o programa “rode”

P B e e Dt Popiene Tk Goflre G 10
@AY TERLN $a

Figura 9 - Execucao em modo Animate

Checksum: Bud175

Figura 8 - Realizando uma gravacao para depuracao

em modo “Run” até aquele ponto,
parando em seguida.

Na figura 10 colocamos um Break-
point na instrugdo “RETURN”". Assim,
o programa ird rodar de forma rapida
e também vai parar antes de voltar ao
programa principal.

A maneira mais facil de inserir um
Breakpoint é dando dois cliques em
cima da linha onde queremos que 0
programa pare.

Observe, que para quase todos o0s
modelos s6 dispomos de 1 Breakpoint
por vez, mas podemos programar
diversos Breakpoints e habilita-los um
por vez usando a tecla F2, lembrando
sempre de desativar o anterior antes
de ativar um novo Breakpoint.

v iR Bhe
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Qutra caracteristica do Breakpoint é que ele pode
“escorregar” parando uma ou duas instrugbes mais
adiante, dependendo do PIC utilizado.

Step Into (F7)

Apés uma parada por um Breakpoint, poderemos
analisar passo a passo, de forma controlada, o restante do
programa. Para isso empregamos o comando “Step Into’
ou simplesmente a tecla F7. Cada vez que esta tecla for
pressionada o programa irda “avancar”’ uma linha.

Step Over (F8)

Este comando tem a mesma funcao da anterior, porém,
com uma pequena diferenca. Sempre que ele encontrar
uma instrucdo “CALL”", ele ira executar a sub-rotina de
forma acelerada. Na pratica nédo é tao interessante para
sub-rotinas de temporizagdes (com varios Loops) e
outras maiores, visto que podemos ficar muito tempo
esperando o seu término. Mas tem praticidade para
pequenas sub-rotinas.

Microcontroladores

Visualizando os registradores

Outro importante recurso do uso de um depurador é
podermos visualizar e interagir nos registradores. Na figura
11 temos a seqiiéncia para visualizar os Registradores de
Funcdes Especiais (SFR), enquanto que na figura 12 temos
os valores destes registradores.

Os valores s¢ sdo atualizados “On Line” nos modos
Animate ou Step Into / Over. No modo Run sé haverd
atualizacdo dos valores apés uma parada por Breakpoint
ou pela agdo Hall.

Uma vez que a execugdo do programa esteja parada,
podemos alterar os valores dos registradores e ver o que
acontece. Experimente alterar o valor do registrador “PORTA”

M Special Function Registers

- Apostila completa (a mesma
do curso presencial).

- Aula particular introdutéria
para apresentagédo da

Curso Tedrico e Pratico apostila e da placa.

Bropram ase e smalo sprontes)

. Lancamento: PICLABS5 .

Seu laboratério
definitivo para
aprendizado e
desenvolvimento
com PIC's.

| - Varias experiéncias
(RS-485, RTC, PWM,
teclado, displays,.. )

Fsl%{ura 11 - Visualizando os reglstradores de funcoes especiais
(SRF)
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para 1 (um) e depois para 0
(zero). Com isso fazemos o
LED acender e apagar manu-
almente.

Utilizando o ICD2BR
como um gravador

Ap6s a depuracao e
testes de um programa,
poderemos fazer a gravagao
do cdédigo-fonte no PIC, de
forma que o programa fun-
cione sem a necessidade do
ICD 2.

Na revista Eletrénica
Total n? 116 vimos como
utilizar os gravadores compativeis com
o MPLAB IDE, o McFlash e o McPlus.
Os procedimentos para leitura, grava-
¢ao, verificagdo, etc., sdo bastante
similares, o que muda é s6 a selecéo
do tipo de gravador.

Lembre-se, para que o projeto rode
fora do depurador, é necessario que
se faga uma nova gravagéo sem o0s
itens de depuracao (“_DEBUG_OFF”)
e se for o caso, a ativacdo do WDT
(“_WDT_ON").

Na figura 13 vemos a seqiéncia
para ativar o depurador /CD28A como
gravador. A janela na sequéncia so
nos informa que o ICD 2 n&o pode ser
empregado simultaneamente como
gravador e depurador.

Para evitar esta mensagem, pode-
mos antes informar ao MPLABE IDE
que nao iremos usar mais o Debugger,
clicando em Debugger > Select Tool
> None.

Algumas Dicas

e Evite sair do MPLAB IDE sem
antes desabilitar o /ICD 2 / ICD2BR.
Em alguns casos o Windows podera

1 MPLAB IDE encontrou us problema ¢ precisa ser
lechado.

estava babahardo pode tes 5o peschdas.
i clioue aou

_ Do |

Figura 14 - Erro ao sair do MPLAB IDE
sem finalizar o ICD 2

¢Oes carentes da regiao.
e O produto ICD 2,
original da Microchip,
como o nome ja diz, é
o segundo circuito elabo-
rado pela Microchip. O
primeiro modelo, langado
na década de 90, ainda
pode ser montado pelo
leitor, uma vez que estao
disponiveis todas as infor-
magdes necessarias no
site da Microchip.
Porém, o ICD “1” tem
algumas limitagdes como,

Figura 13 - Ativagéo do ICD 2 como um gravador

retornar uma mensagem de erro,
similar a da figura 14. Para desabilitar
o ICD 2/ ICD2BR clique em Debbuger
> Select Tool > None ou se vocé
estiver utilizando-o como um gravador,
clique em Programmer > Select Tool
> None.

e Ao sair de um projeto, salve
sempre a configuragéo (figura 15).
Dessa maneira ao abri-lo novamente,
o projeto estara da mesma forma que
foi finalizado.

e A cada nova versdao do MPLAB
IDE, sera feita de forma automatica
a atualizagdo do firmware, ou como
a Microchip denomina, do “Sistema
Operacional’ do ICD 2 ou ICD2BR.
Esse processo ocorre de forma auto-
matica quando selecionamos um novo
modelo de PIC e na maioria dos casos
so solicita a confirmagdo do usudrio.
como podemos ver na figura 16.

» No caso do ICD2BR, néo deixe de
ler o manual do usuario, pois existem
varias dicas interessantes.

Algumas curiosidades

e O ICD2BR ¢ um produto desen-
volvido no Brasil pela LabTools
(www.labtools.com.br) em parceria
com a Microchip. Dessa forma, néao
deixa de ser uma ferramenta oficial
da Microchip.

¢ A LabTools repassa 3% do valor
da venda de cada /CD2BR para institui-

por exemplo:

a. Poucos modelos
que ele consegue depu-
rar ou gravar.

b. Interface com o computador
somente através de uma porta serial.

c. S6 funciona até a versao 5 do
MPLAB IDE.

Consideracoes finais

Uma ferramenta de depuragéo e
um item que deve ser levado em conta
durante o aprendizado, tornando-se
quase indispensavel no desenvolvi-
mento de projetos utilizando PICs.

Com o ICD2BAR tendo um custo
bastante accessivel e ainda contando
com o aval da Microchip, ele € uma
excelente opgéao, principalmente se o
leitor ainda nao dispde de gravador. T

& Do vou wish b save the warkspace befors closing?

[ Sim ” }&’i i Cancelar l

Figura 15 - Salvando a area de trabalho

MPLAR ICD 2 Warning

arrilI30: MPLAB ICD2 i about to download & new operating system.
W MPLAB IDE i st starting. it wil appeas to " ol the splash sciean
Pleacs be patient. IDE wod firsshit's indi after the 05 is
4 hidte: Youmeswith sorre s piged
fubure |
[] Dioet display thes wasning agein

Figura 16 - Atualizacdo automatica do
firmware (Sistema Operacional}
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Montagem

Descre /emos a seguir, a montagem de um
circuito didatico que além de servir para

demonstrar o principio de funcionamento dos
diodos, também consiste em um excelente
teste de habilidade, que pode ser aplicado nas
pessoas com as mais diversas finalidades. O
projeto é extremamente simples, podendo
ser realizado mesmo pelos leitores que nao
tenham muita experiéncia com a eletroénica.

idéia basica desse quebra-cabe-

cas reside totalmente no prin-

cipio de funcionamento dos diodos
semicondutores.

Conforme mostra a figura 1, se

polarizarmos um diodo no sentido

direto (veja as posicdes do anodo e
catodo), ele deixa passar a corrente,
oferecendo pouquissima oposi¢éo ou
resisténcia.

No entanto, se polarizarmos o diodo
no sentido inverso, ele praticamente

ucbra-cabecas
etroni

Newton C. Braga

+

Corrente !y
— -~ Lampada
— >~ acesa
Bateria \

Polarizagao
Figura 1 - Polarizacao direta

direta

nao deixarda passar corrente alguma,
observe a figura 2.

Fica claro que se tivermos varios
diodos ligados em série e um LED
para indicar a passagem da corrente,
conforme ilustra a figura 3, esta so
poderé circular nesse circuito se todos
os diodos estiverem polarizados no
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Diodo
* l N&o ha corrente
e Lampada
_— apagada

Figura 2 - Polarizacao inversa

Corrente

—P—P—P—

+ Diodos polarizados
no sentido direto

-I-Baten'a

Figura 3 - Ha corrente

R
%

LED aceso

sentido direto. E com isso, o LED se
acendera.

Se um unico diodo desse conjunto
estiver polarizado no sentido inverso,
veja a figura 4, a corrente sera blo-
queada e o LED nao acendera.

Né&o hé corrente

f
Diodo polarizado
+ inversamente

==m bloqueando a corrente

TBataria LED apagad

Figura 4 - Nao ha corrente

Nosso projeto

O que fazemos nesse caso, é uti-
lizar dois conjuntos de 3 tomadas
ligadas em série, tendo no final de
cada uma um LED indicador com um
resistor limitador de corrente.

Em cada tomada deveremos encai-
xar um plugue que tem ligado um
diodo. Todavia, nao podemos ver 0
modo que esse diodo esta ligado, pois
ele esta embutido na peca.

Assim, somente se os trés plugues
forem encaixados na posigdo certa,
que leve os diodos a polarizagéo direta,
é que a corrente podera passar e 0s

ELETRONICA T07AL - N° 118 / 2006
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]
Plugues—3%»

acow— 0 — -...—&‘P_(J} —&A—b} -
& I
Pilhas s ' !
- Tomadas | /N
&Y LED
1 aceso
Figura 5 - Plugues encaixados na posicao correta
LEDs acenderem, conforme a figura Montagem

5 demonstra.

A finalidade do jogo é simples:
o jogador tera a sua disposigdo 6
plugues iguais. Devera entédo fazer
tentativas no sentido de obter a com-
binagédo de posigbes (invertendo-os
tantas vezes quantas sejam necessa-
rias) até que os dois LEDs acendam.
O vencedor de uma competicdo sera
aquele que conseguir isso N0 menor
tempo possivel.

Figura 6 - Esquema elétrico

Na figura 6 temos o diagrama
completo do quebra-cabegas.

A disposigao real dos componentes
é apresentada na figura 7.

Usamos, nesse projeto, dois con-
juntos de trés tomadas que podem
ser adquiridos em qualquer casa
de material elétrico. Os diodos séo
1N4002 ou qualquer equivalente. Os
LEDs serdo instalados em pontes de

1N4148

Figura 7 - Disposicao dos componentes
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; Montagem
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terminais juntamente com os resisto-
res, e para a alimentacéo empregamos
4 pilhas pequenas em um suporte
apropriado.

Os diodos sao embutidos nos plu-
gues, conforme mostra a figura 8.
Esses plugues devem ser fechados de
modo que o jogador néo possa ver as
posigdes dos diodos. Evidentemente,
os diodos devem ser colocados em
posi¢des aleatdrias.

Poderao ser empregados até mais
de 6, tornando assim mais interessante
o jogo. Pode-se usar alguns plugues
a mais e vazios para tornar ainda
mais dificil a obtengédo da combinacéo
correta.

Os dois conjuntos de tomadas
podem ser instalados numa caixa,
conforme demonstrado na pdagina ao
lado.

Logica

E interessante notar que o jogo,
apesar de ser um quebra-cabegas
envolvendo o principio de funcio-
namento dos diodos, também tem
fundamentos na légica digital, isso
para a sua resolugéo.

Se partirmos do fato de que séo
utilizadas todas as tomadas com
diodos, e que eles tém apenas dois
estados de condugéo, podemos asso-
ciar os valores digitais 0 ao diodo sem
conduzir e 1 ao diodo conduzindo.

Assim, a combinacédo certa é
aquela em que temos os diodos nas
posicoes 111 e 111 para os dois
conjuntos. Levando-se em conta que
111111 nos da o digital 63, fica claro
que o jogo admite 64 combinagGes
possiveis: de 000 000 a 111 111.

Se o leitor usar dois jogos de 4
tomadas, o nimero de combinagdes
subira para 256. Os LEDs s6 acen-
derdao com 1111 e 1111. Usando 10
tomadas o nimero crescera para
1024!

Entretanto, o jogo é mais simples
porque trabalhamos com dois LEDs.

Desse modo, temos 8 combinagtes
possiveis apenas para cada LED. Se
o leitor conhece a numeracgéao binaria,
podera facilmente fazer as inversées
de maneira programada, e assim obter
a solugdo com menos de 8 tentativas

Lista de Materiais

D-| a Dg— 1N4143 ou 1”@2
~ diodos mttﬂcadoresou de use
- geral i
LED;, LED, - LEDs comuns
(qualquer cor) i
R{,R;-470 Q2 x 1/BW — msmto«
res — amarelo, violeta, marrom
P4 a Pg - Plugues comuns para
arede de energia
X4 a X3 — Dois conjuntos de trés
tomadas comuns para a rede de
energia ou trés tomadas separa-
das
B;-6V -4 pilhas nequanas

Diversos:

Caixa para montagem, suporte
de pilhas, pontes de terminais,
fios, solda, etc. o

Figura 8 - Colocacao do diodo

para cada LED ou no maximo 16 para
os dois LEDs.

Basta lembrar que a sequéncia
natural de combinag¢des possiveis para
os diodos é:

000
001
010
011
100
101
110
111
Caixa pronta e pintada (note a colo-

Considere essa numeragéao € pro
cacéo de “pés” na tampa de baixo).

ceda do seguinte modo:

a) Assuma que a combinacéo inicial
é 000;

b) Inverta o primeiro 001;

c¢) Desinverta o primeiro e inverta
o segundo 010;

d) Inverta novamente o primeiro
011;

e) Desinverta os dois primeiros 6
inverta o terceiro 100;

f) Inverta o primeiro 101;

g) Desinverta o primeiro e inverta
o segundo 110;

h) Inverta o primeiro 111.

Com esse procedimento, indepen-
dentemente do modo como os diodos
estejam, o leitor tera testado todas as
combinagGes possiveis e numa delas
certamente o LED acendera! T

Detalhes internos da caixa
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'Caixa de plastico para
quebra-cabeg eletronico

José Francci Junior

Y Ve

partir
! poliestire
. construir caixas P
mais diversos circuitos € a Total n° 117), seguindo

Existe uma enorme varieQ3e Pdos ja amplamente divulgados
caixas plasticas disponiveis no mer- numa série de artigos publicados na
cado e dimensionadas especifica- revista Mecatronica Facil. Mas para Acomodagéo das tomadas
mente para acomodar circuitos e  aqueles que no tiveram oportunidade e circuitos na caixa
aparelhos eletronicos diversos, porém, de acompanhé-la, ha um fink no site 2
muitas vezes elas ndo atendem as  da revista (www.eletronicatotal.com.br)
nossas necessidades. O caso do  que aponta para uma série de
quebra-cabecas eletronico é bem  dicas de como trabalhar com
atipico devido ao grande numero de  plastico.
tomadas utilizadas na construgéo. Os leitores devem obser-

A caixa foi dimensionadade modoa  var que o modelo e a distri-
ser a mais compacta possivel, inclusive  buigao utilizados por nds,
com a o uso de dois suportes para  sdo apenas uma sugestao
duas pilhas AA, ligadas em série  entre muitas! Ha inumeras g~
para melhor distribuigdo interna. A formas possiveis, 0 que
construgéo foi executada com chapas inclusive dependera do
de plastico de 2 mme 1 mm de espes-  tipo de tomada que o
sura, da mesma maneira vista no “pro- leitor dispuser. Entéo,
blema do barqueiro” (confirana Revista ~ méos a obra!
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Quadrinhos

MAS QUE
#els@!!!

ISSO E
FACIL! DEIXA
COMIGO!

SEMANAS TENTANDO
RESOLVER ESTE CUBO
MAGICO! DEVE ESTAR

COM DEFEITO/

E A TORRADEIRA MICROCONTROLADA
: DO JOAO ALBERTO!

#cls@!!!

FUNCIONOU!
QUE

ELA DISSE QUE SE '\
FIZERMOS AS TORRADAS
DO JOAO POR TRES
MESES ELA NAO CONTA
PRA NINGUEM/

“DE DUAS VOLTAS N
NA FACE SUPERIOR,
TRES NA ESQUERDA
E UMA NA DE BAIXO”/
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eZ430-F2013
Completa Ferramenta de
Desenvolvimento

Apenas US$ 15 (FoB)

Prego Normal US$ 20 (FOB)

G
W TEXAS INSTRUMENTS

;;"flf .
. MSP430 | MCUs

| CONCURSO DE
PROJETOS |

VISP430eZ W

Mostre-nos o que vocé tem feito, participando do Concurso de Projetos MSP430 eZ.
Entre nesta competicao e faga como projetistas \do mundo inteiro, enviando o seu projeto baseado
no MSP 430 da Texas Instruments - o microcontrolador de menor consumo do mundo.

Fécil de Participar Fécil de Ganhar

*Néo é necessdrio efetuar nenhuma compra para ® Envie seu projeto até o dia 02 de Outubro de 2006.
participar. * Os primeiro, segundo e terceiro lugares receberéo,

*Teste a Ferramenta de Desenvolvimento eZ430-F2013  cada um, uma TV de alta resolugio DLP e a
gratuitamente no VirtuaLab da Tech On Line. participagéo na Conferéncia Técnica MSP430, em

*Receba 25% de desconto na compra da feramenta ~ Dallas, que acontecera do dia 07 a 09 de
eZ430-F2013. Novembro de 2006 (passagem aérea e hospedagem

*Envie seu projeto hoje! pagos pela Texas).

www.ti.com/designmsp430

Texas Instruments — www.ti.com/brasil - e-mail: texas-suporte@ti.com - tel.: (11) 5504-5133
Distribuidores: Arrow (11) 3613-9300; Avnet (11) 5079-2150; Farnell-Newark InOne (11) 4066-9400.
Consultores / 3" Parties: www.ti.com/3p e www.ti.com/brasil3p

Techalogy for Innovators, o banner preto/vermelho e DLP séo marcas registradas da Texas Instruments.
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Placas estanhadas sem chumbo ("Lead-free")
Furagao e contorno por CNC
Transferéncia fotogréfica de imagem
Maéscara Photoimageable
Hot Air Levelling

 Fotoplotagem a laser

CIRCUITOS
IMPRESSOS TEC-CI.
* AESCOLHA E SUA.
A RESPONSABILIDADE,

B A TEC-Cl sabe que oferecer tecnologia e Este & um dos grandes diferenciais TEC-Cl.
rapidez na entrega dos seus produtos sdo Proporcionar aos nossos clientes '
condicdes indispensaveis para quem esta : ‘atendimento individual,
comprometido com os seus clientes.  oferecendo solugbes para cada caso,

Mas a TEC-Cl foi além. Saiu na frente na
produgdo de placas de circuito impresso
"Lead-free” (livres de chumbo) diminuindo
seus impactos ambientais.

E com essa visao, de crescer com
responsabilidade, de investir em tecnologia,
de qualificar seus profissionais e de
respeitar 0 meio ambiente que garantimos
um grande diferencial e conquistamos a
cada dia maior participagao de mercado.

‘com o méaximo de rapidez.

RESPONSABILIDADE

Quem ganha é vocé. Esta é a palavra-chave de uma
empresa comprometida com o futuro de
nosso planeta. E a TEC-Cl saiu na frente
produzindo as suas placas livres de chumbo
("Lead-free"), tdo danoso a natureza.
Uma opgdo sem custo para o
seu bolso e para o meio ambiente.
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